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ibm.com and related resources

Product support and documentation are available from ibm.com®.

Support and assistance

Product support is available on the Web. Click Support from the product Web site
at:

Content Manager EE
http://www.ibm.com/software/data/cm/cmgr/mp/edition-
enterprise.html

Content Manager for z/OS®

http://www.ibm.com/software/data/cm/cmgr/390/

Information center

You can view the product documentation in an Eclipse-based information center
that you can install when you install the product. By default, the information
center runs in a Web server mode that other Web browsers can access. You can also
run it locally on your workstation. See the information center at
http://publib.boulder.ibm.com/infocenter/cmgmt/v8r4m0/index.jsp.

PDF publications

You can view the PDF files online using the Adobe® Acrobat Reader for your
operating system. If you do not have the Acrobat Reader installed, you can
download it from the Adobe Web site at http://www.adobe.com.

See the following PDF publications Web sites:

Product Web site

Content Manager EE http://www.ibm.com/support/docview.wss?rs=86
&uid=swg27015910

Content Manager for z/OS http://www.ibm.com/support/docview.wss?rs=119
&uid=swg27015911

“How to send your comments”
“Contacting IBM” on page iv

How to send your comments
Your feedback is important in helping to provide the most accurate and highest
quality information.

Send your comments by using the online reader comment form at
https://www14.software.ibm.com/webapp/iwm/web/signup.do?lang=en_US
&source=swg-rcf.
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Consumability survey

You are invited to tell IBM how to improve the consumability of software
products. If you want to help IBM make Content Manager EE easier to use, take
the Consumability Survey at http://www.ibm.com/software/data/info/
consumability-survey/.
Parent topic: “ibm.com and related resources” on page iii

Contacting IBM
To contact IBM customer service in the United States or Canada, call
1-800-IBM-SERV (1-800-426-7378).

To learn about available service options, call one of the following numbers:
v In the United States: 1-888-426-4343
v In Canada: 1-800-465-9600

For more information about how to contact IBM, see the Contact IBM Web site at
http://www.ibm.com/contact/us/.
Parent topic: “ibm.com and related resources” on page iii
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Preparing for non-English installations

IBM® Enterprise Content Management Widgets is Unicode-enabled to support
multiple languages and the installation package contains the necessary
Multilingual user interface files. A separate installation step is not required to
install the translated version.

Available languages for IBM ECM Widgets

The IBM ECM Widgets V4.5.2 installation program supports English only. The
configuration manager supports multiple languages. In addition to English, IBM
ECM Widgets displays the user interface in the following languages:

Language Locale

Arabic ar

Chinese (Simplified) zh-CN

Chinese (Traditional) zh-TW

French fr

German de

Italian it

Japanese ja

Korean ko

Polish pl

Portuguese (Brazilian) pt-BR

Russian ru

Spanish es

For configurations that use IBM FileNet® Content Manager object
stores

For platform-specific details regarding IBM FileNet P8 Platform on the supported
levels of independent software vendor components and version requirements for
non-English installations on configurations that use IBM FileNet Content Manager
object stores, see:
v IBM FileNet P8 Hardware and Software Requirements guide
v Non-English environment considerations topic in the Plan and Prepare Your

Environment for IBM FileNet P8 guide
v IBM FileNet P8 Non-English Support Guide

To download these documents from the IBM Web site, see the Product
Documentation for FileNet P8 Platform support page: http://www.ibm.com/
support/docview.wss?rs=3247&uid=swg27010422.
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Installing IBM ECM Widgets

IBM ECM Widgets can be installed and deployed on IBM WebSphere® Application
Server configurations using Business Space powered by WebSphere on AIX® and
Windows® platforms.

Based on your configuration, choose one of the following options to install and
deploy IBM ECM Widgets:

“Installing IBM ECM Widgets on IBM WebSphere Application Server - Base”
“Collocating IBM ECM Widgets with a WebSphere Application Server Business
Process Management product” on page 22
“Installing a Highly Available IBM WebSphere Application Server Network
Deployment of IBM ECM Widgets” on page 35

Installing IBM ECM Widgets on IBM WebSphere Application Server -
Base

For WebSphere Application Server - Base configurations, Business Space powered
by WebSphere must be deployed manually before you can install IBM ECM
Widgets.

Use this configuration option to deploy Business Space powered by WebSphere on
IBM WebSphere Application Server and then deploy IBM ECM Widgets.
1. “Planning the installation”
2. “Installing prerequisite software” on page 4
3. “Installing IBM ECM Widgets” on page 5
4. “Installing the Business Space powered by WebSphere installation package to

your WebSphere Application Server home directory” on page 7
5. “Preparing a database for Business Space powered by WebSphere” on page 9
6. “Deploying Business Space powered by WebSphere on IBM WebSphere

Application Server” on page 12
7. “Running the IBM ECM Widgets Configuration Manager” on page 18
8. “(Optional) Setting the IBM FileNet Workplace XT cookie path” on page 20
9. “(Optional) Configuring step processor locations for IBM ECM Widgets” on

page 20
10. “Verifying IBM ECM Widgets and Business Space powered by WebSphere

deployment” on page 21
Parent topic: “Installing IBM ECM Widgets”

Planning the installation
Before you install IBM ECM Widgets, you must decide which method you will use
to deploy Business Space powered by WebSphere. The method you choose
determines the order in which the various prerequisite software components must
be installed.

For new installations on WebSphere Application Server, the order in which the
prerequisite software is installed, deployed and configured is determined by
whether you want to deploy Business Space to an existing WebSphere Application
Server profile or a new profile.
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Business Space powered by WebSphere must be installed and deployed in one of
two ways:
v Deploy to an existing WebSphere Application Server profile that has all the

prerequisite software already installed, deployed, and configured. You then
configure Business Space.

v In one step, create a new profile and deploy an already-configured Business
Space application, after which you then need to install, deploy, and configure all
prerequisite components in the newly created profile.

Parent topic: “Installing IBM ECM Widgets on IBM WebSphere Application Server
- Base” on page 3
Next topic: “Installing prerequisite software”

Installing prerequisite software
Before you install IBM ECM Widgets, different prerequisite components are
required, depending on which type of IBM Content Manager content server you
use.

For configurations that use IBM FileNet Content Manager object
stores:
v IBM WebSphere Application Server
v IBM Installation Manager. This product can be downloaded from the IBM Web

site at the following location: http://www.ibm.com/support/
docview.wss?uid=swg24024682

v Database: use either DB2® for Linux®, UNIX® and Windows or Oracle
v Content Engine
v Process Engine

Important: The following components must be deployed to the same profile on the
IBM WebSphere Application Server:
v IBM FileNet Workplace XT

Note: At this point, install IBM FileNet Workplace XT, but do not deploy yet.
v Content Engine Client
v Process Engine Client with REST service enabled

Note: For details regarding configuring REST services, see the Configuring REST
Services topic in the IBM FileNet P8 Platform Installation and Upgrade Guide in the
following location:http://publib.boulder.ibm.com/infocenter/p8docs/v4r5m1/
topic/com.ibm.p8.doc/developer_help/process_java_api/guide/rest/
rest_configure.htm.

v (Optional) eForms

For supported versions of required platform software, see the IBM FileNet P8
Hardware and Software Requirements document on the IBM Web site. For
supported versions of required FileNet P8 Software, see the IBM FileNet P8
Compatibility document on the IBM Web site.

For configurations that use IBM DB2 Content Manager content
servers
v IBM WebSphere Application Server
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v IBM Installation Manager. This product can be downloaded from the IBM Web
site at the following location: http://www.ibm.com/support/
docview.wss?uid=swg24024682

v Database: use DB2 for Linux, UNIX and Windows or Oracle
v IBM DB2 Content Manager with IBM WEBi

For WebSphere Application Server Network Deployment High
Availability configurations

To configure WebSphere Application Server Network Deployment for High
Availability (HA) with IBM ECM Widgets, the following additional components are
required:
v IBM HTTP Server
v IBM HTTP Server Plugin

You must install WebSphere Application Server Network Deployment or
WebSphere Application Server - base on all nodes in your system.

For details on creating and configuring a clustered environment, see the
WebSphere Application Server Network Deployment online information center:
http://publib.boulder.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/
com.ibm.websphere.nd.doc/info/ae/ae/welcome_nd.html
Parent topic: “Installing IBM ECM Widgets on IBM WebSphere Application Server
- Base” on page 3
Previous topic: “Planning the installation” on page 3
Next topic: “Installing IBM ECM Widgets”

Installing IBM ECM Widgets
The IBM ECM Widgets installation program also installs the package that is used
to deploy Business Space powered by WebSphere for systems where manual
deployment is necessary.

Running the IBM ECM Widgets installation program adds the files necessary to
install and deploy the following components:
v Business Space powered by WebSphere
v IBM ECM Widgets for configurations that use either IBM FileNet Content

Manager object stores or IBM DB2 Content Manager content servers

You can run the IBM ECM Widgets installation program in one of two ways:
“Installing IBM ECM Widgets interactively”
“Installing IBM ECM Widgets V4.5.2 silently” on page 6

Parent topic: “Installing IBM ECM Widgets on IBM WebSphere Application Server
- Base” on page 3
Previous topic: “Installing prerequisite software” on page 4
Next topic: “Installing the Business Space powered by WebSphere installation
package to your WebSphere Application Server home directory” on page 7

Installing IBM ECM Widgets interactively
You can run the IBM ECM Widgets installation program interactively and step
through the installer screens.

To install the IBM ECM Widgets software:
1. Log on to the host computer and copy the installation package to a local drive.
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2. From the installation package, run the appropriate installation program for
your configuration:

Option Description

AIX ECMWidgets4_5_2AIX.bin

Windows ECMWidgets4_5_2WIN.exe

3. Complete the fields in the installation program.
4. Review the pre-installation summary and click Install.
5. Review the installation summary. If errors occurred, see the log file in the

following location:

Option Description

AIX ECMWidgets_Home/
IBM_ECM_Widgets_Install.log

Windows ECMWidgets_Home\
IBM_ECM_Widgets_Install.log

For example, the log file is saved to the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/
IBM_ECM_Widgets_Install.log

Windows C:\Program Files\IBM\ECMWidgets\
IBM_ECM_Widgets_Install.log

Parent topic: “Installing IBM ECM Widgets” on page 5

Installing IBM ECM Widgets V4.5.2 silently
You can run the IBM ECM Widgets installation silently. You must install IBM ECM
Widgets V4.5.2 before you can install the V4.5.2.1 update.

To silently install IBM ECM Widgets, enter values about your environment in the
ECMWidgets_silent_input.properties file. Then, start the silent installation from a
command line. You can configure the required properties file in one of two ways:
v Manually edit and modify the options in the

ECMWidgets_silent_input.properties file that is included in the installation
package.

v Run an installation interactively and have the installer record the options that
you set in the ECMWidgets_silent_input.properties file. This file can then be
used to install silently on additional computers, and use the options that you
recorded during your interactive installation. To silently install IBM ECM
Widgets:

1. Log on to the host computer by using an account that has administrator
privileges.

2. Copy the IBM ECM Widgets installation package to the host computer and
prepare the properties file:
v To modify the properties file included in the installation package, open the

ECMWidgets_silent_input.properties file and follow the instructions within
to modify the options. The properties that you enter are not case sensitive.

Restriction: You must change the license agreement option from false to
true or the installation will not run.
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v To create a properties file by running the installation program, select the
option to create the file during the installation. After the file is created,
replace the file in the installation package with the file that you generated.

3. For non-English installations only: If the ECMWidgets_silent_input.properties
file contains non-English characters, convert the file by using the native2ascii
tool:

Tip: If you accept the default installation paths that are recorded in the
ECMWidgets_silent_input.properties file, conversion of the file will not be
necessary.
a. From the JAVA_JDK_Home\bin directory, run the following command:

native2ascii source_file target_file

For example:
native2ascii ECMWidgets_silent_input.properties intermediate.txt

4. Start the installation by running the following command:

Option Description

AIX ECMWidgets4_5_2AIX.bin -i silent -f
target_file

Windows ECMWidgets4_5_2WIN.exe -i silent -f
target_file

5. Review the installation summary. If errors occurred, see the log file in the
following location:

Option Description

AIX ECMWidgets_Home/
IBM_ECM_Widgets_Install.log

Windows ECMWidgets_Home\
IBM_ECM_Widgets_Install.log

For example, the log file is saved to the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/
IBM_ECM_Widgets_Install.log

Windows C:\Program Files\IBM\ECMWidgets\
IBM_ECM_Widgets_Install.log

Parent topic: “Installing IBM ECM Widgets” on page 5

Installing the Business Space powered by WebSphere
installation package to your WebSphere Application Server
home directory

Using IBM Installation Manager, you must install the Business Space package into
the WebSphere Application Server directory structure before you can deploy
Business Space.

Before you begin, ensure IBM Installation Manager V1.3.3 or later is installed.

To run IBM Installation Manager and install the Business Space installation
package to the WebSphere Application Server home directory:

Installing IBM ECM Widgets 7



1. Start IBM Installation Manager.
2. Click File → Preferences.
3. In the Repositories window, click Add Repository.
4. In the Add a Repository window, click Browse. Browse to the BusinessSpace

directory within the IBM ECM Widgets installation location, select the
bscc.7000.repository.zip file and click OK. The file is installed in following
location:

Option Description

AIX ECMWidgets_Home/BusinessSpace/
bscc.7000.repository.zip

Windows ECMWidgets_Home\BusinessSpace\
bscc.7000.repository.zip

For example, the file is located in the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/
bscc.7000.repository.zip

Windows C:\Program Files\IBM\ECMWidgets\
BusinessSpace\bscc.7000.repository.zip

5. In the Add a Repository window, click Browse.
6. Browse to the BusinessSpace directory within the IBM ECM Widgets

installation location, select the bspace7.IFix.repository.zip file and click
OK. The file is installed in the following location:

Option Description

AIX ECMWidgets_Home/
bspace7.IFix.repository.zip

Windows ECMWidgets_Home\
bspace7.IFix.repository.zip

For example, the file is located in the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/
bspace7.IFix.repository.zip

Windows C:\Program Files\IBM\ECMWidgets
\BusinessSpace\
bspace7.IFix.repository.zip

7. In the Add a Repository window, click Browse.
8. Browse to the BusinessSpace directory within the IBM ECM Widgets

installation location, open the was-sync directory and select the
repository.config file. Click OK. The file is installed in the following
location:

Option Description

AIX ECMWidgets_Home/BusinessSpace/was-sync/
respository.config

Windows ECMWidgets_Home\BusinessSpace\was-sync\
repository.config
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For example, the file is located in the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/was-
sync/respository.config

Windows C:\Program Files\IBM\ECMWidgets\
BusinessSpace\was-sync\repository.config

9. Click OK in the Repositories window.
10. Click the Import icon.
11. In the Import Existing WebSphere Installation window, click the Installation

Directory dropdown menu and select the appropriate WebSphere installation
directory, for example:

Option Description

AIX /opt/IBM/WebSphere/AppServer

Windows C:\ProgramFiles\IBM\WebSphere\AppServer

12. Click Next.
13. Specify a Shared Resources Directory and click Next.
14. Click Import.
15. Click Finish.
16. Click the Install icon.
17. In the Install Packages window, select the com.ibm.ws.bspace package and

click Next. The Install Packages window will display the package name and
installation directory you have selected.

18. Verify the information and then click Next. The Install Packages window will
display the package features that will be installed.

19. Click Next. The Install Packages window will display summary information
about the options you have selected.

20. Click Install.
21. Click Finish after the installation completes and then exit IBM Installation

Manager.
Parent topic: “Installing IBM ECM Widgets on IBM WebSphere Application Server
- Base” on page 3
Previous topic: “Installing IBM ECM Widgets” on page 5
Next topic: “Preparing a database for Business Space powered by WebSphere”

Preparing a database for Business Space powered by
WebSphere

A database is required for Business Space powered by WebSphere in order to
install IBM ECM Widgets.

The method you use to prepare the database depends on your configuration.
Choose one of the following options:

“Preparing an IBM DB2 for Linux, UNIX and Windows database for
configurations where DB2 and IBM ECM Widgets are collocated” on page 10
“Preparing a database for IBM DB2 for Linux, UNIX and Windows
configurations where DB2 is installed remotely from IBM ECM Widgets” on
page 11
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“Preparing a Business Space powered by WebSphere database for Oracle
configurations” on page 12

Parent topic: “Installing IBM ECM Widgets on IBM WebSphere Application Server
- Base” on page 3
Previous topic: “Installing the Business Space powered by WebSphere installation
package to your WebSphere Application Server home directory” on page 7
Next topic: “Deploying Business Space powered by WebSphere on IBM WebSphere
Application Server” on page 12

Preparing an IBM DB2 for Linux, UNIX and Windows database for
configurations where DB2 and IBM ECM Widgets are collocated
If DB2 and IBM ECM Widgets are collocated on the same computer, you must
modify a properties file so a new database will be created when Business Space is
deployed.

When you deploy Business Space powered by WebSphere, a new database for DB2
for Linux, UNIX and Windows is automatically created based on the properties
you specify in the BSpace_DB2-distributed.properties file. To prepare the file:
1. Create a copy of the BSpace_DB2-distributed.properties template file and save

it to a new location. The file is installed in the following location:

Option Description

AIX WAS_Home/BusinessSpace/config.bspace
/MetadataFiles/

Windows WAS_home\BusinessSpace\config.bspace
\MetadataFiles\

For example:

Option Description

AIX Copy the file from:

/opt/IBM/WebSphere/AppServer/
BusinessSpace/config.bspace/
MetadataFiles/BSpace_DB2-
distributed.properties

Save the file to:

/tmp/BSpace_DB2-distributed.properties

Windows Copy the file from:

C:\Program Files\IBM\WebSphere\
AppServer\BusinessSpace\config.bspace\
MetadataFiles \BSpace_DB2-
distributed.properties

Save the file to:

C:\BSpace_DB2-distributed.properties

2. Open the copy of the BSpace_DB2-distributed.properties file in a text editor
and, using the instructions in the file, edit the appropriate values.
Attention: For Windows configurations, if Program Files is part of your
temporary path location, it must be entered as:
C:/Progra~1/

3. Save and close the file.
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Parent topic: “Preparing a database for Business Space powered by WebSphere” on
page 9

Preparing a database for IBM DB2 for Linux, UNIX and Windows
configurations where DB2 is installed remotely from IBM ECM
Widgets
If DB2 is remote from the IBM ECM Widgets installation, you must create an
empty database and modify a properties file.

To prepare an IBM DB2 for Linux, UNIX and Windows database for Business
Space powered by WebSphere:
1. Create a copy of the BSpace_DB2-distributed.properties template file and save

it to a new location. The file is installed in the following location:

Option Description

AIX WAS_Home/BusinessSpace/config.bspace/
MetadataFiles/

Windows WAS_home\BusinessSpace\config.bspace\
MetadataFiles\

For example:

Option Description

AIX Copy the file from:

/opt/IBM/WebSphere/AppServer/
BusinessSpace/config.bspace/
MetadataFiles/BSpace_DB2-
distributed.properties

Save the file to:

/tmp/BSpace_DB2-distributed.properties

Windows Copy the file from:

C:\Program Files\IBM\WebSphere\
AppServer\BusinessSpace\config.bspace\
MetadataFiles\BSpace_DB2-
distributed.properties

Save the file to:

C:\BSpace_DB2-distributed.properties

2. Open the copy of the BSpace_DB2-distributed.properties file in a text editor
and, using the instructions in the file, edit the appropriate values.

Important: For Windows configurations, if Program Files is part of your
temporary path location, it must be entered as:
C:/Progra~1/

3. Save and close the file.
4. Create an empty DB2 database by using the createDatabase.sql script in the

following location: WAS_home\BusinessSpace\mm.config\dbscripts\DB2\
createDatabase.sql.

Tip: Change the value for @DB_NAME@ in the script to the name of the new
database you are creating.
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Parent topic: “Preparing a database for Business Space powered by WebSphere” on
page 9

Preparing a Business Space powered by WebSphere database
for Oracle configurations
For Oracle configurations, you must create an empty database and modify a
properties file before you deploy Business Space.

To prepare an Oracle database for Business Space powered by WebSphere:
1. Create a copy of the BSpace_Oracle.properties template file and save it to a

new location. The file is installed in the following location:

Option Description

AIX WAS_Home/BusinessSpace/config.bspace/
MetadataFiles/

Windows WAS_home\BusinessSpace\config.bspace\
MetadataFiles\

For example:

Option Description

AIX Copy the file from:

/opt/IBM/WebSphere/AppServer/
BusinessSpace/config.bspace/
MetadataFiles/BSpace_Oracle.properties

Save the file to:

/tmp/BSpace_Oracle.properties

Windows Copy the file from:

C:\Program Files\IBM\WebSphere\
AppServer\BusinessSpace\config.bspace\
MetadataFiles\BSpace_Oracle.properties

Save the file to:

C:\BSpace_Oracle.properties

2. Open the copy of the BSpace_Oracle.properties file in a text editor and, using
the instructions in the file, edit the appropriate values.

Important: For Windows configurations, if Program Files is part of your
temporary path location, it must be entered as:
C:/Progra~1/

3. Save and close the file.
4. Create an empty Oracle database that uses the UTF-8 character set.
Parent topic: “Preparing a database for Business Space powered by WebSphere” on
page 9

Deploying Business Space powered by WebSphere on IBM
WebSphere Application Server

Depending on which method of installation you chose for deploying Business
Space powered by WebSphere when you planned the installation, deploy Business
Space using one of two command-line methods:
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“Deploying Business Space powered by WebSphere to an existing WebSphere
Application Server profile”
“Creating a new profile and deploying a pre-configured instance of Business
Space powered by WebSphere” on page 15

Parent topic: “Installing IBM ECM Widgets on IBM WebSphere Application Server
- Base” on page 3
Previous topic: “Preparing a database for Business Space powered by WebSphere”
on page 9
Next topic: “Running the IBM ECM Widgets Configuration Manager” on page 18

Deploying Business Space powered by WebSphere to an
existing WebSphere Application Server profile
Use this method to deploy Business Space if you already have an IBM WebSphere
Application Server profile.

To deploy Business Space powered by WebSphere:
1. From a command prompt, access the bin directory located in the WebSphere

Application Server installation home directory and run the appropriate
command for your configuration:

Windows

v For configurations that use IBM DB2 for Linux, UNIX and Windows
database, enter the following command in one line:
manageprofiles.bat -augment -profileName profileName -cellName cellName
-nodeName nodeName -templatePath ..\profileTemplates\BusinessSpace

\default.bspace -enableAdminSecurity true -adminUserName Admin_username
-adminPassword Admin_PWD -bspacedbDesign temp_copy_path

\BSpace_DB2-distributed.properties -dbDelayConfig false -dbCreateNew
true_or_false

Important:

– For DB2 databases that are local to the IBM ECM Widgets
installation, enter:
-dbCreateNew true

– For DB2 databases that are remote, enter:
-dbCreateNew false

For example, for a configuration with a local DB2 database, access
C:\Program Files\IBM\WebSphere\AppServer\bin\ and enter the
following command in one line:
manageprofiles.bat -augment -profileName AppSrv01 -nodeName myserverNode01
-cellName myserverNode01cell -templatePath ..\profileTemplates
\BusinessSpace\default.bspace -enableAdminSecurity true -adminUserName
administrator -adminPassword mypassword -bspacedbDesign
C:\BSpace_DB2-distributed.properties -dbDelayConfig false -dbCreateNew true

v For configurations that use Oracle database, enter the following
command in one line:
manageprofiles.bat -augment -profileName profileName -cellName cellName
-nodeName nodeName -templatePath ..\profileTemplates\BusinessSpace

\default.bspace -enableAdminSecurity true -adminUserName Admin_username
-adminPassword Admin_PWD -bspacedbDesign temp_copy_path\

BSpace_Oracle.properties -dbDelayConfig true -dbCreateNew false

For example, access C:\Program Files\IBM\WebSphere\AppServer\
bin\ and enter the following command in one line:
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manageprofiles.bat -augment -profileName AppSrv01 -nodeName myserverNode01
-cellName myserverNode01cell -templatePath ..\profileTemplates\BusinessSpace
\default.bspace -enableAdminSecurity true -adminUserName administrator
-adminPassword mypassword -bspacedbDesign C:\BSpace_Oracle.properties
-dbDelayConfig true -dbCreateNew false

AIX

v For configurations that use IBM DB2 for Linux, UNIX and Windows
database, enter the following command in one line:
manageprofiles.sh -augment -profileName profileName -cellName cellName
-nodeName nodeName -templatePath ../profileTemplates/BusinessSpace

/default.bspace -enableAdminSecurity true -adminUserName Admin_username
-adminPassword Admin_PWD -bspacedbDesign temp_copy_path
/BSpace_DB2-distributed.properties -dbDelayConfig false -dbCreateNew
true_or_false

Important:

– For DB2 databases that are local to the IBM ECM Widgets
installation, enter:
-dbCreateNew true

– For DB2 databases that are remote, enter:
-dbCreateNew false

For example, for a configuration with a local DB2 database, access
C:\Program Files\IBM\WebSphere\AppServer\bin\ and enter the
following command in one line:
manageprofiles.sh -augment -profileName AppSrv01 -nodeName myserverNode01
-cellName myserverNode01cell -templatePath ../profileTemplates
/BusinessSpace/default.bspace -enableAdminSecurity true -adminUserName
administrator -adminPassword mypassword -bspacedbDesign /tmp
/BSpace_DB2-distributed.properties -dbDelayConfig false -dbCreateNew true

v For configurations that use Oracle database, enter the following
command in one line:
manageprofiles.sh -augment -profileName profileName -cellName cellName
-nodeName nodeName -templatePath ../profileTemplates/BusinessSpace

/default.bspace -enableAdminSecurity true -adminUserName Admin_username
-adminPassword Admin_PWD -bspacedbDesign temp_copy_path
/BSpace_Oracle.properties -dbDelayConfig true -dbCreateNew false

For example, access /opt/IBM/WebSphere/AppServer/bin/ and enter
the following command in one line:
manageprofiles.bat -augment -profileName AppSrv01 -nodeName myserverNode01
-cellName myserverNode01cell -templatePath ../profileTemplates/BusinessSpace
/default.bspace -enableAdminSecurity true -adminUserName adminstrator
-adminPassword mypassword -bspacedbDesign /tmp/BSpace_Oracle.properties
-dbDelayConfig true -dbCreateNew false

Restriction: The command must complete with the following result to have
been successful:
INSTCONFSUCCESS: Profile augmentation succeeded

If you did not receive the correct result, investigate the log files that are listed.
2. For configurations that use Oracle database, complete the following steps:

For configurations where Oracle is installed locally to IBM ECM Widgets

a. Access the SQL files which are stored in the following location:
WAS_Home/profiles/profileName/dbscripts/BusnessSpace/
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nodeName/Oracle/databaseName. For AIX systems, ensure the
directory is set to have read/write/execute permissions for a user
who will execute the SQL scripts.

b. Open the createSchmea.sql file and replace @DB_PASSWORD@
with the password in the database properties file.

c. Log in as a user with permissions to run the configBusinessSpaceDB
script. Run configBusinessSpaceDB.sh on AIX or
configBusinessSpaceDB.bat on Windows. You will be prompted for
a username and password for an Oracle DBA user.

For configurations where Oracle is installed remotely from IBM ECM
Widgets

a. Copy the SQL files directory from Profile_Home\dbscripts\
BusinessSpace\nodeName\Oracle\databaseName to the database
system. For AIX systems, ensure the directory is set to have
read/write/execute permissions for a user who will execute the
SQL scripts. For example, copy the files from:
WAS_Home/profiles/AppSrv01/dbscripts/BusinessSpace/myNode/Oracle/bspacedb

b. Execute the following scripts:
v createTablespace.sql

v createSchema.sql

Important: Ensure you change the user password before
executing createSchema.sql.

v createTable.sql

v createGrant.sql

v createTables_BusinessSpace.sql

3. Enable application security by entering the following command:

Option Description

AIX wsadmin.sh -username username -password
password -conntype NONE -lang jython -c
"AdminTask.setAdminActiveSecuritySettings
('[-appSecurityEnabled true]')"

Windows wsadmin -username username -password
password -conntype NONE -lang jython -c
"AdminTask.setAdminActiveSecuritySettings
('[-appSecurityEnabled true]')"

Parent topic: “Deploying Business Space powered by WebSphere on IBM
WebSphere Application Server” on page 12

Creating a new profile and deploying a pre-configured instance
of Business Space powered by WebSphere
Use this method to deploy Business Space if you do not have an IBM WebSphere
Application Server profile. The command will create a new profile and deploy a
new instance of Business Space powered by WebSphere.

To create a new profile and deploy a pre-configured instance of Business Space
powered by WebSphere to your WebSphere Application Server:
1. From a command prompt, access the bin directory located in your WebSphere

Application Server profile home directory and run the appropriate command
for your configuration:
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Windows

v For configurations that use DB2 for Linux, UNIX and Windows
database, enter the following command in one line:
manageprofiles.bat -create -templatePath ..\profileTemplates\BusinessSpace
\default.bspace -enableAdminSecurity true -adminUserName
Admin_username -adminPassword Admin_PWD
-bspacedbDesign temp_copy_path\
BSpace_DB2-distributed.properties -dbDelayConfig false -dbCreateNew true

Important:

– For DB2 databases that are local to the IBM ECM Widgets
installation, enter:
-dbCreateNew true

– For DB2 databases that are remote, enter:
-dbCreateNew false

For example, for a configuration with a local DB2 database, access
C:\Program Files\IBM\WebSphere\AppServer\bin\ and enter the
following command in one line:
manageprofiles.bat -create -templatePath ..\profileTemplates\BusinessSpace
\default.bspace -enableAdminSecurity true -adminUserName administrator
-adminPassword mypassword -bspacedbDesign
C:\BSpace_DB2-distributed.properties -dbDelayConfig true -dbCreateNew true

v For configurations that use Oracle database, enter the following
command in one line:
manageprofiles.bat -create -templatePath ..\profileTemplates\BusinessSpace
\default.bspace -enableAdminSecurity true -adminUserName Admin_username
-adminPassword Admin_PWD -bspacedbDesign temp_copy_path
\BSpace_Oracle.properties -dbDelayConfig true

For example, access C:\Program Files\IBM\WebSphere\AppServer\
bin\ and enter the following command in one line:
manageprofiles.sh -create -templatePath ..\profileTemplates\BusinessSpace
\default.bspace -enableAdminSecurity true -adminUserName administrator
-adminPassword mypassword -bspacedbDesign C:\BSpace_Oracle.properties
-dbDelayConfig false

AIX

v For configurations that use DB2 for Linux, UNIX and Windows
database, enter the following command in one line:
manageprofiles.sh -create -templatePath ../profileTemplates/BusinessSpace
/default.bspace -enableAdminSecurity true -adminUserName
Admin_username -adminPassword Admin_PWD
-bspacedbDesign temp_copy_path/BSpace_DB2-distributed.properties
-dbDelayConfig false -dbCreateNew true

Important:

– For DB2 databases that are local to the IBM ECM Widgets
installation, enter:
-dbCreateNew true

– For DB2 databases that are remote, enter:
-dbCreateNew false

For example, for a configuration with a local DB2 database, access
C:\Program Files\IBM\WebSphere\AppServer\bin\ and enter the
following command in one line:
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manageprofiles.sh -create -templatePath ../profileTemplates/BusinessSpace
/default.bspace -enableAdminSecurity true -adminUserName administrator
-adminPassword mypassword -bspacedbDesign
/tmp/BSpace_DB2-distributed.properties -dbDelayConfig false
-dbCreateNew true

v For configurations that use Oracle database, enter the following
command in one line:
manageprofiles.sh -create -templatePath ../profileTemplates/BusinessSpace
/default.bspace -enableAdminSecurity true -adminUserName
Admin_username -adminPassword Admin_PWD
-bspacedbDesign temp_copy_path/BSpace_Oracle.properties -dbDelayConfig true

For example, access /opt/IBM/WebSphere/AppServer/bin/ and enter
the following command in one line:
manageprofiles.sh -create -templatePath ../profileTemplates/BusinessSpace
/default.bspace -enableAdminSecurity true -adminUserName administrator
-adminPassword mypassword -bspacedbDesign /tmp/BSpace_Oracle.properties
-dbDelayConfig true

2. For configurations that use Oracle database, complete the following steps:

For configurations where Oracle is installed locally to IBM ECM Widgets

a. Access the SQL files which are stored in the following location:
WAS_Home/profiles/profileName/dbscripts/BusnessSpace/
nodeName/Oracle/databaseName. For AIX systems, ensure the
directory is set to have read/write/execute permissions for a user
who will execute the SQL scripts.

b. Open the createSchmea.sql file and replace @DB_PASSWORD@
with the password in the database properties file.

c. Log in as a user with permissions to run the configBusinessSpaceDB
script. Run configBusinessSpaceDB.sh on AIX or
configBusinessSpaceDB.bat on Windows. You will be prompted for
a username and password for an Oracle DBA user.

For configurations where Oracle is installed remotely from IBM ECM
Widgets

a. Copy the SQL files directory from Profile_Home\dbscripts\
BusinessSpace\nodeName\Oracle\databaseName to the database
system. For AIX systems, ensure the directory is set to have
read/write/execute permissions for a user who will execute the
SQL scripts. For example, copy the files from:
WAS_Home/profiles/AppSrv01/dbscripts/BusinessSpace/myNode/Oracle/bspacedb

b. Execute the following scripts:
v createTablespace.sql

v createSchema.sql

Important: Ensure you change the user password before
executing createSchema.sql.

v createTable.sql

v createGrant.sql

v createTables_BusinessSpace.sql

3. Enable application security by entering the following command:
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Option Description

AIX wsadmin.sh -username username -password
password -conntype NONE -lang jython -c
"AdminTask.setAdminActiveSecuritySettings
('[-appSecurityEnabled true]')"

Windows wsadmin -username username -password
password -conntype NONE -lang jython -c
"AdminTask.setAdminActiveSecuritySettings
('[-appSecurityEnabled true]')"

4. For configurations that use IBM FileNet Content Manager object stores, install
IBM FileNet Workplace XT and configure WebSphere Application Server for
IBM FileNet Workplace XT but do not deploy the application until after you
run the IBM ECM Widgets Configuration Manager to deploy IBM ECM
Widgets. For details, see the IBM FileNet Workplace XT Installation and
Upgrade Guide.

Parent topic: “Deploying Business Space powered by WebSphere on IBM
WebSphere Application Server” on page 12
Related concepts

IBM FileNet Workplace XT Installation and Upgrade Guide

Running the IBM ECM Widgets Configuration Manager
Run the Configuration Manager to deploy IBM ECM Widgets on your IBM
WebSphere Application Server profile and configure the necessary settings.

Gather the following information before you start the deployment:
v IBM WebSphere Application Server Settings:

– Home directory path
– Profile name
– Administrator log on credentials
– SOAP Connector address port

For configurations that use IBM FileNet Content Manager object stores:
v Workplace XT installation path
v Process Engine REST API URL
v Content Engine services URL

For configurations that use IBM DB2 Content Manager content servers:
v IBM WEBi URL.

To deploy ECM Widgets on WebSphere Application Server:
1. Start the IBM WebSphere Application Server.
2. Launch the IBM ECM Widgets Configuration Manager:

Option Description

AIX Access the installation directory and run the
ConfigMgr file. For example, run the file
from the following default installation
location:

/opt/IBM/ECMWidgets/ConfigMgr/ConfigMgr
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Option Description

Windows Click Start → All Programs → IBM ECM
Widgets → Configuration Manager

3. Follow the instructions on the IBM ECM Widgets Configuration Manager
screens and enter the required details about your configuration.

4. Click Finish to complete the deployment.
5. If any errors occurred, review the configuration log for details. Run the IBM

ECM Widgets Configuration Manager again. The log is located in the logs
directory of the installation path. For example, the log is stored in the following
default location:

Option Description

AIX /opt/IBM/ECMWidgets/logs

Windows C:\Program Files\IBM\ECMWidgets\logs

Tip: For configurations that use IBM FileNet Content Manager object stores,
the IBM ECM Widgets configuration manager rebuilt the IBM FileNet
Workplace XT WAR and EAR files.

6. (optional) Enable the ecmX theme. As part of the IBM ECM Widgets
installation, a new Business Space theme was installed. In order to make this
theme available to end users, you must enable it using the following procedure.

Note: To enable this style later, a restart of WebSphere Application Server will
be necessary.
a. Click Servers → Server Types → WebSphere application servers.
b. Click on the server where Business Space is deployed.
c. Click Java and Process Management → Process Definition → Environment

Entries.
d. Click New to create a new Environment Entry.
e. Enter BSPACE_STYLE_EXT_DIR in the Name field.
f. Enter the path to the styles folder in your IBM ECM Widgets installation

directory. For example, the folder is installed in the following default
location:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/styles

Windows C:\Program Files\IBM\ECMWidgets\
BusinessSpace\styles

g. Click Apply and then click Save directly to the master configuration.
7. For configurations that use IBM FileNet Content Manager object stores,

redeploy IBM FileNet Workplace XT and set the Class load settings according
to the instructions in the IBM FileNet Workplace XT Installation and Upgrade
Guide.

8. Stop and restart the IBM WebSphere Application Server.
9. For configurations that use IBM FileNet Content Manager object stores, restart

the Process WPXT Services Manager according to the instructions in the IBM
FileNet Workplace XT Installation and Upgrade Guide.
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Parent topic: “Installing IBM ECM Widgets on IBM WebSphere Application Server
- Base” on page 3
Previous topic: “Deploying Business Space powered by WebSphere on IBM
WebSphere Application Server” on page 12
Next topic: “(Optional) Setting the IBM FileNet Workplace XT cookie path”

(Optional) Setting the IBM FileNet Workplace XT cookie path
Complete this task only if your configuration uses IBM FileNet Content Manager
object stores.

To set the IBM FileNet Workplace XT cookie path:
1. Access the WebSphere Application Server administrative console and click

Applications → Application Types → WebSphere Enterprise Applications.
2. Click Workplace XT.
3. Click Session management under Web Module Properties.
4. Click Enable cookies.
5. Enter a unique path in which to store this application's cookies in the Cookie

path field and click OK. For example:
/WorkplaceXT

6. Select the Override session management option under General Properties and
click Apply.

7. Click Save directly to the master configuration.
8. Restart Workplace XT.
Parent topic: “Installing IBM ECM Widgets on IBM WebSphere Application Server
- Base” on page 3
Previous topic: “Running the IBM ECM Widgets Configuration Manager” on page
18
Next topic: “(Optional) Configuring step processor locations for IBM ECM
Widgets”

(Optional) Configuring step processor locations for IBM ECM
Widgets

Complete this task only if your configuration uses IBM FileNet Content Manager
object stores and you want to configure step processors.

To configure step processor locations for IBM ECM Widgets:
1. Create the Business Space powered by WebSphere pages for your step

processor launch and steps, as appropriate for your configuration. For details
about configuring and integrating IBM FileNet P8 workflow applications and
step processor locations, see http://publib.boulder.ibm.com/infocenter/
p8docs/v4r5m1/topic/com.ibm.p8.doc/pe_help/config/
region_configure_step_processors.htm

2. Log on to IBM FileNet Workplace XT and navigate to Tools → Administration
→ Process Configuration Console.

3. Right-click the region you want to edit and choose Connect.
4. Right-click the region you want to edit and choose Properties.
5. Click the Step Processor Info tab.
6. Click the Add icon.
7. Select the Type for the new entry from the dropdown menu.
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8. Enter a name in the Name field.
9. Select HTML from the Language dropdown menu.

10. Double-click the Location field, then access the appropriate page URL for the
step processor and copy the #PID into the Location field. For example, select
the information in bold from the following URL and paste it into the Location
field:
http://localhost:9080/mum/resources/
bootstrap#pid=C0A876BCD8E8DACED43EB9E1F64E4C000012&

11. Repeat as appropriate for each step processor you want to configure.
12. Commit the changes.
Parent topic: “Installing IBM ECM Widgets on IBM WebSphere Application Server
- Base” on page 3
Previous topic: “(Optional) Setting the IBM FileNet Workplace XT cookie path” on
page 20
Next topic: “Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment”

Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment

Verify your configuration by accessing the URLs for each component.

To verify that IBM ECM Widgets and Business Space powered by WebSphere
deployed properly:
1. Open a browser from a remote computer and enter the following default

Business Space URL:

Configuration URL

WebSphere Application Server http://host_server_name:port/mum/enabler

WebSphere Application Server Highly
Available (HA)

http://host_server_name/mum/enabler

2. Open a browser from a remote computer and enter the following default ECM
Widgets Version Information page URL:

Configuration URL

WebSphere Application Server http://host_server_name:port/ECMWidgets/
About.jsp

WebSphere Application Server Highly
Available (HA)

http://host_server_name/ECMWidgets/
About.jsp

The IBM ECM Widgets product is deployed to an instance of Business Space
powered by WebSphere on your server. You can now add IBM ECM Widgets to
Business Spaces and create new Business Space pages.
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Parent topic: “Installing IBM ECM Widgets on IBM WebSphere Application Server
- Base” on page 3
Previous topic: “(Optional) Configuring step processor locations for IBM ECM
Widgets” on page 20

Collocating IBM ECM Widgets with a WebSphere Application Server
Business Process Management product

Business Space powered by WebSphere is automatically deployed as part of the
installation of an IBM WebSphere Application Server Business Process Management
product. In certain configurations, multiple instances of Business Space might be
deployed. Widgets components must be deployed to one instance of Business
Space powered by WebSphere on your configuration.

There are two methods of collocating IBM ECM Widgets with an IBM WebSphere
Application Server Business Process Management product, depending on your
current configuration.

“Installing IBM ECM Widgets to an existing installation of a WebSphere
Application Server Business Process Management product”
“Installing an IBM WebSphere Business Process Management product to an IBM
ECM Widgets configuration” on page 30

Parent topic: “Installing IBM ECM Widgets” on page 3

Installing IBM ECM Widgets to an existing installation of a
WebSphere Application Server Business Process Management
product

If an IBM WebSphere Application Server Business Process Management product is
installed on the configuration to which you want to add IBM ECM Widgets, you
must deploy the IBM ECM Widgets software to the existing instance of Business
Space powered by WebSphere.
1. “Installing prerequisite software”
2. “Installing IBM ECM Widgets” on page 24
3. “Running the IBM ECM Widgets Configuration Manager” on page 26
4. “(Optional) Setting the IBM FileNet Workplace XT cookie path” on page 28
5. “(Optional) Configuring step processor locations for IBM ECM Widgets” on

page 28
6. “Verifying IBM ECM Widgets and Business Space powered by WebSphere

deployment” on page 29
Parent topic: “Collocating IBM ECM Widgets with a WebSphere Application Server
Business Process Management product”

Installing prerequisite software
Before you install IBM ECM Widgets, different prerequisite components are
required, depending on which type of IBM Content Manager content server you
use.

For configurations that use IBM FileNet Content Manager object
stores:
v IBM WebSphere Application Server
v IBM Installation Manager. This product can be downloaded from the IBM Web

site at the following location: http://www.ibm.com/support/
docview.wss?uid=swg24024682

22 Installation and Upgrade Guide

http://www.ibm.com/support/docview.wss?uid=swg24024682
http://www.ibm.com/support/docview.wss?uid=swg24024682


v Database: use either DB2 for Linux, UNIX and Windows or Oracle
v Content Engine
v Process Engine

Important: The following components must be deployed to the same profile on the
IBM WebSphere Application Server:
v IBM FileNet Workplace XT

Note: At this point, install IBM FileNet Workplace XT, but do not deploy yet.
v Content Engine Client
v Process Engine Client with REST service enabled

Note: For details regarding configuring REST services, see the Configuring REST
Services topic in the IBM FileNet P8 Platform Installation and Upgrade Guide in the
following location:http://publib.boulder.ibm.com/infocenter/p8docs/v4r5m1/
topic/com.ibm.p8.doc/developer_help/process_java_api/guide/rest/
rest_configure.htm.

v (Optional) eForms

For supported versions of required platform software, see the IBM FileNet P8
Hardware and Software Requirements document on the IBM Web site. For
supported versions of required FileNet P8 Software, see the IBM FileNet P8
Compatibility document on the IBM Web site.

For configurations that use IBM DB2 Content Manager content servers
v IBM WebSphere Application Server
v IBM Installation Manager. This product can be downloaded from the IBM Web

site at the following location: http://www.ibm.com/support/
docview.wss?uid=swg24024682

v Database: use DB2 for Linux, UNIX and Windows or Oracle
v IBM DB2 Content Manager with IBM WEBi

For WebSphere Application Server Network Deployment High
Availability configurations

To configure WebSphere Application Server Network Deployment for High
Availability (HA) with IBM ECM Widgets, the following additional components are
required:
v IBM HTTP Server
v IBM HTTP Server Plugin

You must install WebSphere Application Server Network Deployment or
WebSphere Application Server - base on all nodes in your system.

For details on creating and configuring a clustered environment, see the
WebSphere Application Server Network Deployment online information center:
http://publib.boulder.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/
com.ibm.websphere.nd.doc/info/ae/ae/welcome_nd.html
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Parent topic: “Installing IBM ECM Widgets to an existing installation of a
WebSphere Application Server Business Process Management product” on page 22
Next topic: “Installing IBM ECM Widgets”

Installing IBM ECM Widgets
The IBM ECM Widgets installation program also installs the package that is used
to deploy Business Space powered by WebSphere for systems where manual
deployment is necessary.

Running the IBM ECM Widgets installation program adds the files necessary to
install and deploy the following components:
v Business Space powered by WebSphere
v IBM ECM Widgets for configurations that use either IBM FileNet Content

Manager object stores or IBM DB2 Content Manager content servers

You can run the IBM ECM Widgets installation program in one of two ways:
“Installing IBM ECM Widgets interactively”
“Installing IBM ECM Widgets V4.5.2 silently” on page 25

Parent topic: “Installing IBM ECM Widgets to an existing installation of a
WebSphere Application Server Business Process Management product” on page 22
Previous topic: “Installing prerequisite software” on page 22
Next topic: “Running the IBM ECM Widgets Configuration Manager” on page 26

Installing IBM ECM Widgets interactively:

You can run the IBM ECM Widgets installation program interactively and step
through the installer screens.

To install the IBM ECM Widgets software:
1. Log on to the host computer and copy the installation package to a local drive.
2. From the installation package, run the appropriate installation program for

your configuration:

Option Description

AIX ECMWidgets4_5_2AIX.bin

Windows ECMWidgets4_5_2WIN.exe

3. Complete the fields in the installation program.
4. Review the pre-installation summary and click Install.
5. Review the installation summary. If errors occurred, see the log file in the

following location:

Option Description

AIX ECMWidgets_Home/
IBM_ECM_Widgets_Install.log

Windows ECMWidgets_Home\
IBM_ECM_Widgets_Install.log

For example, the log file is saved to the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/
IBM_ECM_Widgets_Install.log
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Option Description

Windows C:\Program Files\IBM\ECMWidgets\
IBM_ECM_Widgets_Install.log

Parent topic: “Installing IBM ECM Widgets” on page 24

Installing IBM ECM Widgets V4.5.2 silently:

You can run the IBM ECM Widgets installation silently. You must install IBM ECM
Widgets V4.5.2 before you can install the V4.5.2.1 update.

To silently install IBM ECM Widgets, enter values about your environment in the
ECMWidgets_silent_input.properties file. Then, start the silent installation from a
command line. You can configure the required properties file in one of two ways:
v Manually edit and modify the options in the

ECMWidgets_silent_input.properties file that is included in the installation
package.

v Run an installation interactively and have the installer record the options that
you set in the ECMWidgets_silent_input.properties file. This file can then be
used to install silently on additional computers, and use the options that you
recorded during your interactive installation. To silently install IBM ECM
Widgets:

1. Log on to the host computer by using an account that has administrator
privileges.

2. Copy the IBM ECM Widgets installation package to the host computer and
prepare the properties file:
v To modify the properties file included in the installation package, open the

ECMWidgets_silent_input.properties file and follow the instructions within
to modify the options. The properties that you enter are not case sensitive.

Restriction: You must change the license agreement option from false to
true or the installation will not run.

v To create a properties file by running the installation program, select the
option to create the file during the installation. After the file is created,
replace the file in the installation package with the file that you generated.

3. For non-English installations only: If the ECMWidgets_silent_input.properties
file contains non-English characters, convert the file by using the native2ascii
tool:

Tip: If you accept the default installation paths that are recorded in the
ECMWidgets_silent_input.properties file, conversion of the file will not be
necessary.
a. From the JAVA_JDK_Home\bin directory, run the following command:

native2ascii source_file target_file

For example:
native2ascii ECMWidgets_silent_input.properties intermediate.txt

4. Start the installation by running the following command:

Option Description

AIX ECMWidgets4_5_2AIX.bin -i silent -f
target_file
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Option Description

Windows ECMWidgets4_5_2WIN.exe -i silent -f
target_file

5. Review the installation summary. If errors occurred, see the log file in the
following location:

Option Description

AIX ECMWidgets_Home/
IBM_ECM_Widgets_Install.log

Windows ECMWidgets_Home\
IBM_ECM_Widgets_Install.log

For example, the log file is saved to the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/
IBM_ECM_Widgets_Install.log

Windows C:\Program Files\IBM\ECMWidgets\
IBM_ECM_Widgets_Install.log

Parent topic: “Installing IBM ECM Widgets” on page 24

Running the IBM ECM Widgets Configuration Manager
Run the Configuration Manager to deploy IBM ECM Widgets on your IBM
WebSphere Application Server profile and configure the necessary settings.

Gather the following information before you start the deployment:
v IBM WebSphere Application Server Settings:

– Home directory path
– Profile name
– Administrator log on credentials
– SOAP Connector address port

For configurations that use IBM FileNet Content Manager object stores:
v Workplace XT installation path
v Process Engine REST API URL
v Content Engine services URL

For configurations that use IBM DB2 Content Manager content servers:
v IBM WEBi URL.

To deploy ECM Widgets on WebSphere Application Server:
1. Start the IBM WebSphere Application Server.
2. Launch the IBM ECM Widgets Configuration Manager:
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Option Description

AIX Access the installation directory and run the
ConfigMgr file. For example, run the file
from the following default installation
location:

/opt/IBM/ECMWidgets/ConfigMgr/ConfigMgr

Windows Click Start → All Programs → IBM ECM
Widgets → Configuration Manager

3. Follow the instructions on the IBM ECM Widgets Configuration Manager
screens and enter the required details about your configuration.

4. Click Finish to complete the deployment.
5. If any errors occurred, review the configuration log for details. Run the IBM

ECM Widgets Configuration Manager again. The log is located in the logs
directory of the installation path. For example, the log is stored in the following
default location:

Option Description

AIX /opt/IBM/ECMWidgets/logs

Windows C:\Program Files\IBM\ECMWidgets\logs

Tip: For configurations that use IBM FileNet Content Manager object stores,
the IBM ECM Widgets configuration manager rebuilt the IBM FileNet
Workplace XT WAR and EAR files.

6. (optional) Enable the ecmX theme. As part of the IBM ECM Widgets
installation, a new Business Space theme was installed. In order to make this
theme available to end users, you must enable it using the following procedure.

Note: To enable this style later, a restart of WebSphere Application Server will
be necessary.
a. Click Servers → Server Types → WebSphere application servers.
b. Click on the server where Business Space is deployed.
c. Click Java and Process Management → Process Definition → Environment

Entries.
d. Click New to create a new Environment Entry.
e. Enter BSPACE_STYLE_EXT_DIR in the Name field.
f. Enter the path to the styles folder in your IBM ECM Widgets installation

directory. For example, the folder is installed in the following default
location:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/styles

Windows C:\Program Files\IBM\ECMWidgets\
BusinessSpace\styles

g. Click Apply and then click Save directly to the master configuration.
7. For configurations that use IBM FileNet Content Manager object stores,

redeploy IBM FileNet Workplace XT and set the Class load settings according
to the instructions in the IBM FileNet Workplace XT Installation and Upgrade
Guide.
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8. Stop and restart the IBM WebSphere Application Server.
9. For configurations that use IBM FileNet Content Manager object stores, restart

the Process WPXT Services Manager according to the instructions in the IBM
FileNet Workplace XT Installation and Upgrade Guide.

Parent topic: “Installing IBM ECM Widgets to an existing installation of a
WebSphere Application Server Business Process Management product” on page 22
Previous topic: “Installing IBM ECM Widgets” on page 24
Next topic: “(Optional) Setting the IBM FileNet Workplace XT cookie path”

(Optional) Setting the IBM FileNet Workplace XT cookie path
Complete this task only if your configuration uses IBM FileNet Content Manager
object stores.

To set the IBM FileNet Workplace XT cookie path:
1. Access the WebSphere Application Server administrative console and click

Applications → Application Types → WebSphere Enterprise Applications.
2. Click Workplace XT.
3. Click Session management under Web Module Properties.
4. Click Enable cookies.
5. Enter a unique path in which to store this application's cookies in the Cookie

path field and click OK. For example:
/WorkplaceXT

6. Select the Override session management option under General Properties and
click Apply.

7. Click Save directly to the master configuration.
8. Restart Workplace XT.
Parent topic: “Installing IBM ECM Widgets to an existing installation of a
WebSphere Application Server Business Process Management product” on page 22
Previous topic: “Running the IBM ECM Widgets Configuration Manager” on page
26
Next topic: “(Optional) Configuring step processor locations for IBM ECM
Widgets”

(Optional) Configuring step processor locations for IBM ECM
Widgets
Complete this task only if your configuration uses IBM FileNet Content Manager
object stores and you want to configure step processors.

To configure step processor locations for IBM ECM Widgets:
1. Create the Business Space powered by WebSphere pages for your step

processor launch and steps, as appropriate for your configuration. For details
about configuring and integrating IBM FileNet P8 workflow applications and
step processor locations, see http://publib.boulder.ibm.com/infocenter/
p8docs/v4r5m1/topic/com.ibm.p8.doc/pe_help/config/
region_configure_step_processors.htm

2. Log on to IBM FileNet Workplace XT and navigate to Tools → Administration
→ Process Configuration Console.

3. Right-click the region you want to edit and choose Connect.
4. Right-click the region you want to edit and choose Properties.
5. Click the Step Processor Info tab.
6. Click the Add icon.
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7. Select the Type for the new entry from the dropdown menu.
8. Enter a name in the Name field.
9. Select HTML from the Language dropdown menu.

10. Double-click the Location field, then access the appropriate page URL for the
step processor and copy the #PID into the Location field. For example, select
the information in bold from the following URL and paste it into the Location
field:
http://localhost:9080/mum/resources/
bootstrap#pid=C0A876BCD8E8DACED43EB9E1F64E4C000012&

11. Repeat as appropriate for each step processor you want to configure.
12. Commit the changes.
Parent topic: “Installing IBM ECM Widgets to an existing installation of a
WebSphere Application Server Business Process Management product” on page 22
Previous topic: “(Optional) Setting the IBM FileNet Workplace XT cookie path” on
page 28
Next topic: “Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment”

Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment
Verify your configuration by accessing the URLs for each component.

To verify that IBM ECM Widgets and Business Space powered by WebSphere
deployed properly:
1. Open a browser from a remote computer and enter the following default

Business Space URL:

Configuration URL

WebSphere Application Server http://host_server_name:port/mum/enabler

WebSphere Application Server Highly
Available (HA)

http://host_server_name/mum/enabler

2. Open a browser from a remote computer and enter the following default ECM
Widgets Version Information page URL:

Configuration URL

WebSphere Application Server http://host_server_name:port/ECMWidgets/
About.jsp

WebSphere Application Server Highly
Available (HA)

http://host_server_name/ECMWidgets/
About.jsp

The IBM ECM Widgets product is deployed to an instance of Business Space
powered by WebSphere on your server. You can now add IBM ECM Widgets to
Business Spaces and create new Business Space pages.
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Parent topic: “Installing IBM ECM Widgets to an existing installation of a
WebSphere Application Server Business Process Management product” on page 22
Previous topic: “(Optional) Configuring step processor locations for IBM ECM
Widgets” on page 28

Installing an IBM WebSphere Business Process Management
product to an IBM ECM Widgets configuration

Installing the IBM WebSphere Business Process Management product deploys an
additional instance of Business Space powered by WebSphere. You must modify
the existing IBM ECM Widgets configuration to use the new Business Space
deployment.
1. “Installing an IBM WebSphere Business Process Management product”
2. “Setting the new Business Space powered by WebSphere deployment to use the

IBM ECM Widgets database”
3. “Running the IBM ECM Widgets configuration manager on an IBM WebSphere

Application Server Business Process Management configuration” on page 31
4. “Deploying IBM FileNet Workplace XT to the new profile directory” on page 33
5. “(Optional) Setting the IBM FileNet Workplace XT cookie path” on page 33
6. “(Optional) Configuring step processor locations for IBM ECM Widgets” on

page 34
7. “Verifying IBM ECM Widgets and Business Space powered by WebSphere

deployment” on page 34
Parent topic: “Collocating IBM ECM Widgets with a WebSphere Application Server
Business Process Management product” on page 22

Installing an IBM WebSphere Business Process Management
product
Installing an IBM WebSphere Business Process Management product will deploy
an additional instance of Business Space powered by WebSphere to your profile.
The existing instance must be removed and the IBM ECM Widgets installation will
have to be moved to the new instance of Business Space.

Install the WebSphere BPM product to your IBM WebSphere Application Server
according to the application's installation instructions. For example, run the
installation for the WebSphere Business Monitor application.
Parent topic: “Installing an IBM WebSphere Business Process Management product
to an IBM ECM Widgets configuration”
Next topic: “Setting the new Business Space powered by WebSphere deployment
to use the IBM ECM Widgets database”

Setting the new Business Space powered by WebSphere
deployment to use the IBM ECM Widgets database
You must adjust your configuration to set the new installation of Business Space to
use the data source and database that was created for the IBM ECM Widgets
deployment.

To adjust the configuration:
1. Access the WebSphere Application Server administrative console for the newly

installed WebSphere Application Server BPM application. For example, access
the Integrated Solutions Console for WebSphere Business Monitor.

2. Click Resources → JDBC → Data Sources.
3. Click Business Space Datasource.
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4. Click JAAS - J2C authentication data under Related Items.
5. Click New on the JAAS - J2C authentication data page.
6. Enter a name for the Alias and set the User ID and Password. Click Apply.

Restriction: The User ID account requires privileges to access the database
and all tables in the database.

7. Click Save directly to the master configuration.
8. Click Business Space Data Source to return to the Business Space Data Source

General Properties page.
9. From the Component-managed authentication alias menu, select the JAAS -

J2C authentication alias that you just created.
10. From the Container-managed authentication alias menu, select the JAAS -

J2C authentication alias that you just created.
11. From the Mapping-configuration alias menu, select the JAAS - J2C

authentication alias that you just created.
12. Enter the name of the database that you created for your existing IBM ECM

Widgets installation in the Database name field, under DB2 Universal data
source properties.

13. Click Save directly to the master configuration and then restart the
WebSphere Application Server.

14. Verify the connection to the data source that you created:
a. Open the WebSphere Application Server administrative console.
b. Access Resources → JDBC → Data Sources.
c. Click Business Space Datasource.
d. Click Test connection. A WebSphere Application Server message indicates

whether connection to the data source was successful.
Parent topic: “Installing an IBM WebSphere Business Process Management product
to an IBM ECM Widgets configuration” on page 30
Previous topic: “Installing an IBM WebSphere Business Process Management
product” on page 30
Next topic: “Running the IBM ECM Widgets configuration manager on an IBM
WebSphere Application Server Business Process Management configuration”

Running the IBM ECM Widgets configuration manager on an IBM
WebSphere Application Server Business Process Management
configuration
Run the IBM ECM Widgets configuration manager to deploy the product to the
new instance of Business Space powered by WebSphere.

Gather the following information before you start the deployment:
v IBM WebSphere Application Server Settings:

– Home directory path
– Profile name
– Administrator log on credentials
– SOAP Connector address port

For configurations that use IBM FileNet Content Manager object stores:
v Workplace XT installation path
v Process Engine REST API URL
v Content Engine services URL
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For configurations that use IBM DB2 Content Manager content servers
v IBM WEBi URL.

To deploy ECM Widgets to the new instance of Business Space:
1. Start the IBM WebSphere Application Server.
2. Launch the IBM ECM Widgets Configuration Manager:

Option Description

AIX Access the installation directory and run the
ConfigMgr file. For example, run the file
from the following default installation
location:

/opt/IBM/ECMWidgets/ConfigMgr/ConfigMgr

Windows Click Start → All Programs → IBM ECM
Widgets → Configuration Manager.

3. Follow the instructions on the IBM ECM Widgets Configuration Manager
screens and enter the required details about your configuration.

4. Click Finish to complete the deployment.
5. If any errors occurred, review the configuration log for details. Run the IBM

ECM Widgets Configuration Manager again. The log is located in the logs
directory of the installation path. For example, the log is stored in the following
default location:

Option Description

AIX /opt/IBM/ECMWidgets/logs

Windows C:\Program Files\IBM\ECMWidgets\logs

Tip: For configurations that use IBM FileNet Content Manager object stores,
the IBM ECM Widgets configuration manager rebuilt the IBM FileNet
Workplace XT WAR and EAR files.

6. (optional) Enable the ecmX theme. As part of the IBM ECM Widgets
installation, a new Business Space theme was installed. In order to make this
theme available to end users, you must enable it using the following procedure.

Note: To enable this style later, a restart of WebSphere Application Server will
be necessary.
a. Click Servers → Server Types → WebSphere application servers.
b. Click on the server where Business Space is deployed.
c. Click Java and Process Management → Process Definition → Environment

Entries.
d. Click New to create a new Environment Entry.
e. Enter BSPACE_STYLE_EXT_DIR in the Name field.
f. Enter the path to the styles folder in your IBM ECM Widgets installation

directory. For example, the folder is stored in the following default location:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/styles

Windows C:\Program Files\IBM\ECMWidgets\
BusinessSpace\styles
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g. Click Apply and then click Save directly to the master configuration.
7. For configurations that use IBM FileNet Content Manager object stores,

redeploy IBM FileNet Workplace XT and set the Class load settings according
to the instructions in the IBM FileNet Workplace XT Installation and Upgrade
Guide.

8. Stop and restart the IBM WebSphere Application Server.
9. For configurations that use IBM FileNet Content Manager object stores, restart

the Process WPXT Services Manager according to the instructions in the IBM
FileNet Workplace XT Installation and Upgrade Guide.

Parent topic: “Installing an IBM WebSphere Business Process Management product
to an IBM ECM Widgets configuration” on page 30
Previous topic: “Setting the new Business Space powered by WebSphere
deployment to use the IBM ECM Widgets database” on page 30
Next topic: “Deploying IBM FileNet Workplace XT to the new profile directory”

Deploying IBM FileNet Workplace XT to the new profile directory
Deploy IBM FileNet Workplace XT to the new IBM WebSphere Application Server
profile directory, where the new IBM WebSphere BPM instance of Business Space
powered by WebSphere is deployed, and configure Workplace XT accordingly.

For details, see the IBM FileNet Workplace XT Installation and Upgrade Guide that
can be downloaded from the IBM Web site Product Documentation for FileNet P8
Platform support page at the following location: http://www.ibm.com/support/
docview.wss?rs=3278&amp;uid=swg27010422.
Parent topic: “Installing an IBM WebSphere Business Process Management product
to an IBM ECM Widgets configuration” on page 30
Previous topic: “Running the IBM ECM Widgets configuration manager on an IBM
WebSphere Application Server Business Process Management configuration” on
page 31
Next topic: “(Optional) Setting the IBM FileNet Workplace XT cookie path”

(Optional) Setting the IBM FileNet Workplace XT cookie path
Complete this task only if your configuration uses IBM FileNet Content Manager
object stores.

To set the IBM FileNet Workplace XT cookie path:
1. Access the WebSphere Application Server administrative console and click

Applications → Application Types → WebSphere Enterprise Applications.
2. Click Workplace XT.
3. Click Session management under Web Module Properties.
4. Click Enable cookies.
5. Enter a unique path in which to store this application's cookies in the Cookie

path field and click OK. For example:
/WorkplaceXT

6. Select the Override session management option under General Properties and
click Apply.

7. Click Save directly to the master configuration.
8. Restart Workplace XT.
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Parent topic: “Installing an IBM WebSphere Business Process Management product
to an IBM ECM Widgets configuration” on page 30
Previous topic: “Deploying IBM FileNet Workplace XT to the new profile
directory” on page 33
Next topic: “(Optional) Configuring step processor locations for IBM ECM
Widgets”

(Optional) Configuring step processor locations for IBM ECM
Widgets
Complete this task only if your configuration uses IBM FileNet Content Manager
object stores and you want to configure step processors.

To configure step processor locations for IBM ECM Widgets:
1. Create the Business Space powered by WebSphere pages for your step

processor launch and steps, as appropriate for your configuration. For details
about configuring and integrating IBM FileNet P8 workflow applications and
step processor locations, see http://publib.boulder.ibm.com/infocenter/
p8docs/v4r5m1/topic/com.ibm.p8.doc/pe_help/config/
region_configure_step_processors.htm

2. Log on to IBM FileNet Workplace XT and navigate to Tools → Administration
→ Process Configuration Console.

3. Right-click the region you want to edit and choose Connect.
4. Right-click the region you want to edit and choose Properties.
5. Click the Step Processor Info tab.
6. Click the Add icon.
7. Select the Type for the new entry from the dropdown menu.
8. Enter a name in the Name field.
9. Select HTML from the Language dropdown menu.

10. Double-click the Location field, then access the appropriate page URL for the
step processor and copy the #PID into the Location field. For example, select
the information in bold from the following URL and paste it into the Location
field:
http://localhost:9080/mum/resources/
bootstrap#pid=C0A876BCD8E8DACED43EB9E1F64E4C000012&

11. Repeat as appropriate for each step processor you want to configure.
12. Commit the changes.
Parent topic: “Installing an IBM WebSphere Business Process Management product
to an IBM ECM Widgets configuration” on page 30
Previous topic: “(Optional) Setting the IBM FileNet Workplace XT cookie path” on
page 33
Next topic: “Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment”

Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment
Verify your configuration by accessing the URLs for each component.

To verify that IBM ECM Widgets and Business Space powered by WebSphere
deployed properly:
1. Open a browser from a remote computer and enter the following default

Business Space URL:
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Configuration URL

WebSphere Application Server http://host_server_name:port/mum/enabler

WebSphere Application Server Highly
Available (HA)

http://host_server_name/mum/enabler

2. Open a browser from a remote computer and enter the following default ECM
Widgets Version Information page URL:

Configuration URL

WebSphere Application Server http://host_server_name:port/ECMWidgets/
About.jsp

WebSphere Application Server Highly
Available (HA)

http://host_server_name/ECMWidgets/
About.jsp

The IBM ECM Widgets product is deployed to an instance of Business Space
powered by WebSphere on your server. You can now add IBM ECM Widgets to
Business Spaces and create new Business Space pages.

Parent topic: “Installing an IBM WebSphere Business Process Management product
to an IBM ECM Widgets configuration” on page 30
Previous topic: “(Optional) Configuring step processor locations for IBM ECM
Widgets” on page 34

Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets

IBM ECM Widgets must be deployed manually on a Highly Available WebSphere
Application Server Network Deployment system because the configuration
manager cannot be used to deploy the components or configure the system.

IBM ECM Widgets configurations that are not part of a cluster are not supported
for High Availability. Managed or unmanaged nodes that are not part of the cluster
are not supported as part of the HA configuration for IBM ECM Widgets.
1. “Installing prerequisite software” on page 36
2. “Installing IBM ECM Widgets on the WebSphere Application Server Network

Deployment configuration” on page 37
3. “Installing the Business Space powered by WebSphere installation package to

your WebSphere Application Server Network Deployment configuration” on
page 38

4. “Preparing a Business Space powered by WebSphere database for High
Availability configurations” on page 40

5. “Configuring the WebSphere Application Server Network Deployment
deployment manager profile for Business Space powered by WebSphere” on
page 42

6. “Creating a data source for a WebSphere Application Server Network
Deployment configuration” on page 43

7. “Deploying Business Space powered by WebSphere on the WebSphere
Application Server Network Deployment configuration” on page 45

8. “Deploying IBM ECM Widgets on a WebSphere Application Server Network
Deployment configuration” on page 47

9. “Configuring and deploying IBM FileNet Workplace XT on a WebSphere
Application Server Network Deployment configuration” on page 48

10. “(Optional) Setting the IBM FileNet Workplace XT cookie path” on page 50
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11. “(Optional) Configuring step processor locations for IBM ECM Widgets” on
page 50

12. “Enable templates for Business Space powered by WebSphere” on page 51
13. “Verifying IBM ECM Widgets and Business Space powered by WebSphere

deployment” on page 51
Parent topic: “Installing IBM ECM Widgets” on page 3

Installing prerequisite software
Before you install IBM ECM Widgets, different prerequisite components are
required, depending on which type of IBM Content Manager content server you
use.

For configurations that use IBM FileNet Content Manager object
stores:
v IBM WebSphere Application Server
v IBM Installation Manager. This product can be downloaded from the IBM Web

site at the following location: http://www.ibm.com/support/
docview.wss?uid=swg24024682

v Database: use either DB2 for Linux, UNIX and Windows or Oracle
v Content Engine
v Process Engine

Important: The following components must be deployed to the same profile on the
IBM WebSphere Application Server:
v IBM FileNet Workplace XT

Note: At this point, install IBM FileNet Workplace XT, but do not deploy yet.
v Content Engine Client
v Process Engine Client with REST service enabled

Note: For details regarding configuring REST services, see the Configuring REST
Services topic in the IBM FileNet P8 Platform Installation and Upgrade Guide in the
following location:http://publib.boulder.ibm.com/infocenter/p8docs/v4r5m1/
topic/com.ibm.p8.doc/developer_help/process_java_api/guide/rest/
rest_configure.htm.

v (Optional) eForms

For supported versions of required platform software, see the IBM FileNet P8
Hardware and Software Requirements document on the IBM Web site. For
supported versions of required FileNet P8 Software, see the IBM FileNet P8
Compatibility document on the IBM Web site.

For configurations that use IBM DB2 Content Manager content
servers
v IBM WebSphere Application Server
v IBM Installation Manager. This product can be downloaded from the IBM Web

site at the following location: http://www.ibm.com/support/
docview.wss?uid=swg24024682

v Database: use DB2 for Linux, UNIX and Windows or Oracle
v IBM DB2 Content Manager with IBM WEBi
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For WebSphere Application Server Network Deployment High
Availability configurations

To configure WebSphere Application Server Network Deployment for High
Availability (HA) with IBM ECM Widgets, the following additional components are
required:
v IBM HTTP Server
v IBM HTTP Server Plugin

You must install WebSphere Application Server Network Deployment or
WebSphere Application Server - base on all nodes in your system.

For details on creating and configuring a clustered environment, see the
WebSphere Application Server Network Deployment online information center:
http://publib.boulder.ibm.com/infocenter/wasinfo/v7r0/index.jsp?topic=/
com.ibm.websphere.nd.doc/info/ae/ae/welcome_nd.html
Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Next topic: “Installing IBM ECM Widgets on the WebSphere Application Server
Network Deployment configuration”

Installing IBM ECM Widgets on the WebSphere Application
Server Network Deployment configuration

Install IBM ECM Widgets on the deployment manager and each node of your
WebSphere Application Server Network Deployment cluster.

To install IBM ECM Widgets on your WebSphere Application Server Network
Deployment configuration:
1. Log on to the host computer by using an account that has administrator

privileges.
2. Copy the installation package to the host computer.
3. Access the installation package and run the appropriate installation program

for your configuration:

Option Description

AIX ECMWidgets4_5_2AIX.bin

Windows ECMWidgets4_5_2WIN.exe

4. In the Specify Installation Options window, select one or both of the following
installation options:
v Install IBM ECM Widgets on this computer to install the product.
v Save your settings in a response file to record the options that you select

during this installation in a file. The response file can be used to silently
install the product on another computer that will use the same settings that
you select during this installation.

5. Specify a directory in which to install the software:
v To accept the default installation path, click Next.
v To repopulate the field with the default installation path, click Restore

Default Folder.
v To navigate to a different installation path, click Choose and browse for the

directory you want to use.
6. Review the pre-installation summary and click Install.
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7. Review the installation summary. If errors occurred, see the log file in the
following default location:

Option Description

AIX /opt/IBM/ECMWidgets/
IBM_ECM_Widgets_Install.log

Windows C:\Program Files\IBM\ECMWidgets\
IBM_ECM_Widgets_Install.log

Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “Installing prerequisite software” on page 36
Next topic: “Installing the Business Space powered by WebSphere installation
package to your WebSphere Application Server Network Deployment
configuration”

Installing the Business Space powered by WebSphere
installation package to your WebSphere Application Server
Network Deployment configuration

Install the Business Space powered by WebSphere installation package to the
deployment manager and each node of your WebSphere Application Server
Network Deployment cluster.

Ensure IBM Installation Manager V1.3.3 or later is installed.

To install the Business Space powered by WebSphere installation package to your
WebSphere Application Server Network Deployment configuration:
1. Log on to the deployment manager computer by using an account that has

administrator privileges.
2. Start IBM Installation Manager.
3. Click File → Preferences.
4. In the Repositories window, click Add Repository.
5. In the Add a Repository window, click Browse.
6. Browse to the IBM ECM Widgets installation directory, select the

bscc.7000.repository.zip file from the BusinessSpace directory, and click
OK. For example:

Option Description

AIX C:\Program Files\IBM\ECMWidgets
\BusinessSpace\bscc.7000.repository.zip

Windows /opt/IBM/ECMWidgets/BusinessSpace
/bscc.7000.repository.zip

7. Browse to the BusinessSpace directory within the IBM ECM Widgets
installation location, select the bspace7.IFix.repository.zip file and click
OK. The file is installed in the following location:

Option Description

AIX ECMWidgets_Home/
bspace7.IFix.repository.zip

Windows ECMWidgets_Home\
bspace7.IFix.repository.zip
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For example, the file is located in the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/
bspace7.IFix.repository.zip

Windows C:\Program Files\IBM\ECMWidgets
\BusinessSpace\
bspace7.IFix.repository.zip

8. In the Add a Repository window, click Browse.
9. Browse to the BusinessSpace directory within the IBM ECM Widgets

installation location, open the was-sync directory and select the
repository.config file. Click OK. The file is installed in the following
location:

Option Description

AIX ECMWidgets_Home/BusinessSpace/was-sync/
respository.config

Windows ECMWidgets_Home\BusinessSpace\was-sync\
repository.config

For example, the file is located in the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/was-
sync/respository.config

Windows C:\Program Files\IBM\ECMWidgets\
BusinessSpace\was-sync\repository.config

10. Click OK on the Repositories window.
11. Click the Import icon.
12. In the Import Existing WebSphere Installation window, click the Installation

Directory dropdown menu and select the appropriate WebSphere installation
directory. For example:

Option Description

AIX /opt/IBM/WebSphere/AppServer

Windows C:\Program Files\IBM\WebSphere\AppServer

13. Click Next.
14. Specify a Shared Resources Directory and click Next.
15. Click Import.
16. Click Finish.
17. Click the Install icon.
18. In the Install Packages window, select the com.ibm.ws.bspace package and

click Next. The Install Packages window will display the package name and
installation directory you have selected.

19. Verify the information and then click Next. The Install Packages window will
display the package features that will be installed.

20. Click Next. The Install Packages window will display summary information
about the options you have selected.

21. Click Install.
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22. Click Finish after the installation completes and then exit IBM Installation
Manager.

Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “Installing IBM ECM Widgets on the WebSphere Application
Server Network Deployment configuration” on page 37
Next topic: “Preparing a Business Space powered by WebSphere database for High
Availability configurations”

Preparing a Business Space powered by WebSphere database
for High Availability configurations

A database is required for Business Space powered by WebSphere in order to
install IBM ECM Widgets. The method you use to prepare the database depends
on your configuration.

For IBM DB2 for Linux, UNIX and Windows configurations where
DB2 is installed on the deployment manager computer

If DB2 is installed on deployment manager computer, you will modify a properties
file that is used to automatically create a new database as part of the Business
Space deployment.

For IBM DB2 for Linux, UNIX and Windows configurations where
DB2 is remote from the deployment manager computer

If DB2 is remote from the computer with your IBM ECM Widgets installation, you
will create an empty database, modify a properties file and then apply the
properties to the empty database before you deploy Business Space.

For configurations that use Oracle

For Oracle configurations, you will create an empty database, modify a properties
file and then apply the properties to the empty database before you deploy
Business Space.

“Preparing an IBM DB2 for Linux, UNIX and Windows database”
“Creating a new Business Space powered by WebSphere Oracle database for a
WebSphere Application Server Network Deployment configuration” on page 41

Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “Installing the Business Space powered by WebSphere installation
package to your WebSphere Application Server Network Deployment
configuration” on page 38
Next topic: “Configuring the WebSphere Application Server Network Deployment
deployment manager profile for Business Space powered by WebSphere” on page
42

Preparing an IBM DB2 for Linux, UNIX and Windows database
For this type of configuration, when you deploy Business Space powered by
WebSphere on your cluster, you must create a new database for DB2 for Linux,
UNIX and Windows and modify a properties file.

To prepare an IBM DB2 for Linux, UNIX and Windows database for configurations
where DB2 is installed on the deployment manager computer:
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1. Create a copy of the BSpace_DB2-distributed.properties template file and save
it to a new location. The file is installed in the following location:

Option Description

AIX WAS_Home/BusinessSpace/config.bspace/
MetadataFiles/

Windows WAS_home\BusinessSpace\config.bspace\
MetadataFiles\

For example:

Option Description

AIX Copy the file from:

/opt/IBM/WebSphere/AppServer/
BusinessSpace/config.bspace/
MetadataFiles/BSpace_DB2-
distributed.properties

Save the file to:

/tmp/BSpace_DB2-distributed.properties

Windows Copy the file from:

C:\Program Files\IBM\WebSphere\
AppServer\BusinessSpace\config.bspace\
MetadataFiles\BSpace_DB2-
distributed.properties

Save the file to:

C:\BSpace_DB2-distributed.properties

2. Open the copy of the BSpace_DB2-distributed.properties file in a text editor
and, using the instructions within, edit the appropriate values.

Important: Do not change the default value of databaseName=BSPACE.
Attention: For Windows configurations, if Program Files is part of your
temporary path location, it must be entered as:
C:/Progra~1/

3. Save and close the file.
4. Create a database by running the following SQL command: create database

DBName using codeset UTF-8 territory US PAGESIZE 32768
Parent topic: “Preparing a Business Space powered by WebSphere database for
High Availability configurations” on page 40

Creating a new Business Space powered by WebSphere Oracle
database for a WebSphere Application Server Network
Deployment configuration
For this type of configuration, when you deploy Business Space powered by
WebSphere on your cluster, a new database for Oracle is created based on the
properties you specify in the BSpace_Oracle.properties file.

To create a new Business Space powered by WebSphere Oracle database for a
WebSphere Application Server Network Deployment configuration:
1. Create a copy of the BSpace_Oracle.properties template file and save it to a

new location. The file is installed in the following location:
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Option Description

AIX WAS_Home/BusinessSpace
/config.bspace/MetadataFiles/

Windows WAS_Home\BusinessSpace
\config.bspace\MetadataFiles\

For example:

Option Description

AIX Copy the file from:

/opt/IBM/WebSphere/AppServer/
BusinessSpace/config.bspace/
MetadataFiles/BSpace_Oracle.properties

Save the file to:

/tmp/BSpace_Oracle.properties

Windows Copy the file from:

C:\Program Files\IBM\WebSphere\
AppServer\BusinessSpace\config.bspace\
MetadataFiles\BSpace_Oracle.properties

Save the file to:

C:\BSpace_Oracle.properties

2. On the deployment manager computer, open the BSpace_Oracle.properties file
in a text editor and using the instructions within the file, edit the appropriate
values. The values for userName and schemaName must be the same.
Attention:

v SchmaName and userName must be the same value.
v The database user, used to create the database, must have privileges to create

Business Space tables and tablespaces.
v For Windows configurations, if Program Files is part of your temporary path

location, it must be entered as:
C:/Progra~1/

3. Save and close the file.
Parent topic: “Preparing a Business Space powered by WebSphere database for
High Availability configurations” on page 40

Configuring the WebSphere Application Server Network
Deployment deployment manager profile for Business Space
powered by WebSphere

The deployment manager profile for your cluster must be configured for Business
Space by running the augment command.

To configure the WebSphere Application Server Network Deployment deployment
manager profile for Business Space powered by WebSphere:
1. Log on to the deployment manager using an account that has administrator

privileges.
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2. From a command prompt, access the bin directory located in the WebSphere
Application Server Network Deployment root directory and run the following
command for either Windows or AIX:
manageprofiles -augment -profileName DmgrProfile -nodeName
DmgrHostnameCellManagerCellMgrNum -cellName DmgrHostnameCellCelNum
-templatePath ../profileTemplates/BusinessSpace/dmgr.bspace
-enableAdminSecurity true -adminUserName administrator -adminPassword
AdminPwd -bspacedbDesign WAS_Home/BusinessSpace/config.bspace
/MetadataFiles/BSpace_DB2-distributed.properties -dbDelayConfig false
-dbCreateNew true

For example:

AIX Access /opt/IBM/WebSphere/AppServer/bin/ and run the following
command:
manageprofiles -augment -profileName Dmgr01 -nodeName DmgrHostCellManager01
-cellName DmgrHostCell01 -templatePath ../profileTemplates/BusinessSpace
/dmgr.bspace -enableAdminSecurity true -adminUserName administrator
-adminPassword myPassword -bspacedbDesign /opt/IBM/WebSphere/AppServer
/BusinessSpace/config.bspace/MetadataFiles
/BSpace_DB2-distributed.properties -dbDelayConfig false -dbCreateNew true

Windows
Access C:\Program Files\IBM\WebSphere\AppServer\bin\ and run the
following command:
manageprofiles -augment -profileName Dmgr01 -nodeName DmgrHostCellManager01
-cellName DmgrHostCell01 -templatePath ../profileTemplates/BusinessSpace
/dmgr.bspace -enableAdminSecurity true -adminUserName administrator
-adminPassword myPassword -bspacedbDesign C:/Progra~1/IBM/WebSphere
/AppServer/BusinessSpace/config.bspace/MetadataFiles
/BSpace_DB2-distributed.properties -dbDelayConfig false -dbCreateNew true

Restriction: The command must complete with the following result to have
been successful:
INSTCONFSUCCESS: Profile augmentation succeeded

If you did not receive the correct result, investigate the log files, as indicated by
the command result.

Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “Preparing a Business Space powered by WebSphere database for
High Availability configurations” on page 40
Next topic: “Creating a data source for a WebSphere Application Server Network
Deployment configuration”

Creating a data source for a WebSphere Application Server
Network Deployment configuration

You must create a new data source and JDBC provider, based on the database used
for your configuration.

To create a WebSphere Application Server Network Deployment data source:
1. Open the WebSphere Application Server Network Deployment Integrated

Solutions console.
2. Navigate to Resources → JDBC → Data Sources.
3. Select the cluster from the Scopes menu.
4. Click New on the Data sources page.
5. Enter a name for the data source in the Data source name field.
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6. Enter jdbc/mashupDS in the JNDI name field and click Next.

7. Click Create new JDBC provider and click Next on the Select JDBC provider
page.

8. Select the following options on the Create new JDBC Provider page and click
Next:

Option Description

IBM DB2 for Linux, UNIX and Windows
database

v DB2 in the Database type field

v DB2 Universal JDBC Driver Provider in
the Provider type field

v XA data source in the Implementation
type field

v DB2 Universal JDBC Driver Provider
(XA) (default) in the Name field

Oracle database v Oracle in the Database type field

v Oracle JDBC Driver in the Provider type
field

v XA data source in the Implementation
type field

v Oracle JDBC Driver (XA) (default) in the
Name field

9. Enter the paths to the JDBC drivers and click Next. For example:

Option Description

AIX IBM DB2 for Linux, UNIX and Windows

v /opt/IBM/SQLLIB/java for the
DB2UNIVERSAL_JDBC_DRIVER_PATH

v /opt/IBM/SQLLIB/lib for the
DB2UNIVERSAL_JDBC_DRIVER
_NATIVEPATH

Oracle database (path to ojdbc6.jar file)
Note: If Oracle database is not installed on
the deployment manager computer, then
you must copy the ojdbc6.jar file to the
deployment manager computer.

v oraclehome/jdbc/lib/ in the
${ORACLE_JDBC_DRIVER_PATH} field

Windows IBM DB2 for Linux, UNIX and Windows

v C:\Program Files\IBM\SQLLIB\java for
the
DB2UNIVERSAL_JDBC_DRIVER_PATH

v C:\Program Files\IBM\SQLLIB\lib for the
DB2UNIVERSAL_JDBC_DRIVER
_NATIVEPATH

Oracle database (path to ojdbc6.jar file)
Note: If Oracle database is not installed on
the deployment manager computer, then
you must copy the ojdbc6.jar file to the
deployment manager computer.

v oraclehome\jdbc\lib\ in the
${ORACLE_JDBC_DRIVER_PATH} field
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10. Enter the following information on the Enter database-specific properties for
the data source page and click Next:

Option Description

IBM DB2 for Linux, UNIX and Windows
database

v Value of 4 for the Driver type

v The name of the database you created in
the Database name field

v localhost for the Server name field

v Accept the default Port number

Oracle database v URL:
jdbc:oracle:thin:@hostname:port:service_name

v Data store helper, as appropriate

v Check Use this data source in container
managed persistence (CMP)

11. Click Next on the Setup security aliases page.
12. Review the information on the Summary page and click Finish.
13. Click Save directly to the master configuration.
14. Access Resources → JDBC → Data sources and click on the new data source

you created.
15. click JAAS - J2C authentication data and then click New on the JAAS - J2C

authentication data page.
16. Enter an alias and authentication information and click OK.
17. Click Save directly to the master configuration.
18. Access Resources → JDBC → Data sources and click on the new data source

you created.
19. Scroll down to Security settings, select the authentication alias you just created

from the dropdown list below Component-managed authentication alias and
click OK.

20. Click Save directly to the master configuration.
21. Restart the deployment manager server and all nodes.
22. Verify the connection to the data source that you created:

a. Open the WebSphere Application Server administrative console.
b. Access Resources → JDBC → Data Sources

c. Select the data source that you created and click Test connection. A
WebSphere Application Server message indicates whether connection to
the data source was successful.

Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “Configuring the WebSphere Application Server Network
Deployment deployment manager profile for Business Space powered by
WebSphere” on page 42
Next topic: “Deploying Business Space powered by WebSphere on the WebSphere
Application Server Network Deployment configuration”

Deploying Business Space powered by WebSphere on the
WebSphere Application Server Network Deployment
configuration

Business Space powered by WebSphere must be deployed manually on the
WebSphere Application Server Network Deployment configuration.

Installing IBM ECM Widgets 45



To deploy Business Space powered by WebSphere on the WebSphere Application
Server Network Deployment configuration:
1. Log on to the deployment manager computer by using an account that has

administrator privileges.
2. From a command prompt, access the bin directory located in the WebSphere

Application Server Network Deployment root directory:

Option Description

AIX /opt/IBM/WebSphere/AppServer/bin/

Windows C:\Program Files\IBM\WebSphere\
AppServer\bin\

3. Access the wsadmin command prompt by entering the following command:
wsadmin.bat -conntype NONE

4. Enter the following command to deploy Business Space to the deployment
manager profile:
$AdminTask installBusinessSpace {-clusterName ClusterName}

For example:
$AdminTask installBusinessSpace {-clusterName myCluster}

5. Enter the following command:
$AdminConfig save

6. Configure Business Space on the deployment manager, enter the following
command from the wsadmin command prompt:
$AdminTask configureBusinessSpace {-clusterName ClusterName -schemaName
BSPACE -tableSpaceName BSPACE -storageGroup BSPACE}

For example:
$AdminTask configureBusinessSpace {-clusterName myCluster -schemaName
BSPACE -tableSpaceName BSPACE -storageGroup BSPACE}

7. Enter the following command:
$AdminConfig save

8. Skip this step if your database is local and you created a new database using
dbcreateNew=true. In all other cases, run the following database scripts:

For DB2 databases

a. Access the database scripts located in
DMGR_PROFILE_HOME\dbscripts\BusinessSpace\clusterName\DB2\databaseName

For example:
C:\IBM\WebSphere\AppServer\profiles\Dmgr01\dbscripts\BusinessSpace
\mycluster\DB2\bspacedb

b. Copy the scripts to the DB2 server. Create a new database and
execute the following scripts on the database:
v createTablespace.sql

v createSchema.sql

v createTable.sql
v createTables_BusinessSpace.sql

For Oracle databases

a. Access the database scripts located in
DMGR_PROFILE_HOME\dbscripts\BusinessSpace\clusterName\Oracle\databaseName
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For example:
C:\IBM\WebSphere\AppServer\profiles\Dmgr01\dbscripts\BusinessSpace\mycluster
\Oracle\bspacedb

b. Create a new database that uses the UTF-8 character set and execute
the following scripts:
v createTablespace.sql

v createSchema.sql

Important: Ensure you change the user password before
executing createSchema.sql.

v createTable.sql

v createGrant.sql

v createTables_BusinessSpace.sql
Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “Creating a data source for a WebSphere Application Server
Network Deployment configuration” on page 43
Next topic: “Deploying IBM ECM Widgets on a WebSphere Application Server
Network Deployment configuration”

Deploying IBM ECM Widgets on a WebSphere Application
Server Network Deployment configuration

You must manually deploy IBM ECM Widgets to your cluster.

Ensure IBM FileNet Workplace XT and related REST services are installed.

To deploy IBM ECM Widgets to the cluster:
1. Log on to the host computer using an account that has administrator privileges.
2. From a command prompt, access the bin directory located in the WebSphere

Application Server Network Deployment deployment manager profile root
directory and run the following command for either Windows or AIX to access
the wsadmin command prompt:
wsadmin -conntype NONE

For example, run the command from the following directory:

Option Description

AIX /opt/IBM/WebSphere/AppServer/profiles/
Dmgr01/bin/

Windows C:\Program Files\IBM\WebSphere\
AppServer\profiles\Dmgr01\bin\

3. At the wsadmin command prompt, enter the following command in one line:

Option Description

AIX $AdminTask installBusinessSpaceWidgets
{-clusterName cluster_name -widgets
widgets_home /Widgets_ECMWidgetsP8.zip}

Windows $AdminTask installBusinessSpaceWidgets
{-clusterName cluster_name -widgets
widgets_home \Widgets_ECMWidgetsP8.zip}

For example:
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Option Description

AIX $AdminTask installBusinessSpaceWidgets
{-clusterName myCluster -widgets
/opt/IBM/ECMWidgets/
Widgets_ECMWidgetsP8.zip}

Windows $AdminTask installBusinessSpaceWidgets
{-clusterName myCluster -widgets
C:\Program Files\IBM\
Widgets_ECMWidgetsP8.zip}

4. Enter $AdminConfig save

5. Adjust the settings in the bootstrap.json file, as appropriate for your
configuration. For details on modifying IBM ECM Widgets configuration
settings, see “Modifying IBM Enterprise Content Management Widgets
configuration settings” on page 77.

Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “Deploying Business Space powered by WebSphere on the
WebSphere Application Server Network Deployment configuration” on page 45
Next topic: “Configuring and deploying IBM FileNet Workplace XT on a
WebSphere Application Server Network Deployment configuration”

Configuring and deploying IBM FileNet Workplace XT on a
WebSphere Application Server Network Deployment
configuration

To deploy Workplace XT on a WebSphere Application Server Network Deployment
configuration, the product must be installed on the deployment manager and
cluster nodes.

To configure and deploy IBM FileNet Workplace XT on a WebSphere Application
Server Network Deployment system:
1. Log on to the deployment manager computer using an account that has

administrator privileges.
2. In a text editor, open the web.xml file from the WEB-INF directory in the IBM

FileNet Workplace XT installation location. For example:

Option Description

AIX /opt/IBM/FileNet/WebClient/WorkplaceXT/
WEB-INF

Windows C:\Program Files\IBM\FileNet\WebClient\
WorkplaceXT\WEB-INF

3. Locate the <servlet> entries section and add the following entries:
<servlet>

<servlet-name>P8CERESTServlet</servlet-name>
<servlet-class>com.ibm.im.ecmwidgets.rest.P8CERESTServlet</servlet-class>

</servlet>
<servlet>

<servlet-name>ecmWidgetForm</servlet-name>
<servlet-class>com.filenet.eforms.apps.server.servlet.ECMWidgetFormServlet</servlet-class>

</servlet>

4. Locate the <servlet-mapping> entries section and add the following entries:
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<servlet-mapping>
<servlet-name>ecmWidgetForm</servlet-name>
<url-pattern>/ecmWidgetForm/*</url-pattern>

</servlet-mapping>
<servlet-mapping>

<servlet-name>P8CERESTServlet</servlet-name>
<url-pattern>/P8CEREST/*</url-pattern>

</servlet-mapping>

5. Copy the ceREST.jar file from the following lib directory in the IBM ECM
Widgets installation location. For example:

Option Description

AIX /opt/IBM/ECMWidgets/ContentList/lib/
ceREST.jar

Windows C:\Program Files\IBM\ECMWidgets\
ContentList\lib\ceREST.jar

Save the file to the lib directory in the Workplace XT installation location. For
example:

Option Description

AIX /opt/IBM/FileNet/WebClient/WorkplaceXT/
WEB-INF/lib/ceREST.jar

Windows C:\Program Files\IBM\FileNet\WebClient\
WorkplaceXT\WEB-INF\lib\ceREST.jar

6. Copy the ECMWidgetFormServlet.jar file from the IBM ECM Widgets
installation location. For example:

Option Description

AIX /opt/IBM/ECMWidgets/
eFormsECMWidgetFormServlet.jar

Windows C:\Program Files\IBM\ECMWidgets\eForms\
ECMWidgetFormServlet.jar

Save the file to the lib directory in the Workplace XT installation location. For
example:

Option Description

AIX /opt/IBM/FileNet/WebClient/WorkplaceXT/
WEB-INF/lib/ECMWidgetFormServlet.jar

Windows C:\Program Files\IBM\FileNet\WebClient\
WorkplaceXT\WEB-INF\lib\
ECMWidgetFormServlet.jar

7. Recreate the Workplace XT WAR and EAR files and deploy Workplace XT. For
details, see the IBM FileNet Workplace XT Installation and Upgrade Guide
which can be downloaded from the IBM Web site Product Documentation for
FileNet P8 Platform support page at the following location:
http://www.ibm.com/support/docview.wss?rs=3278&amp;uid=swg27010422.
Use the following options which are unique to deploying on a WebSphere
Application Server Network Deployment configuration:
v Select the CellManager as the node name that contains your Workplace XT

application.
v Choose Detailed - Show all installation options and parameters on the

Preparing for the application installation page.
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v On the Map modules to servers page, select the cluster, the web server and
the application and then click Apply.

Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “Deploying IBM ECM Widgets on a WebSphere Application Server
Network Deployment configuration” on page 47
Next topic: “(Optional) Setting the IBM FileNet Workplace XT cookie path”

(Optional) Setting the IBM FileNet Workplace XT cookie path
Complete this task only if your configuration uses IBM FileNet Content Manager
object stores.

To set the IBM FileNet Workplace XT cookie path:
1. Access the WebSphere Application Server administrative console and click

Applications → Application Types → WebSphere Enterprise Applications.
2. Click Workplace XT.
3. Click Session management under Web Module Properties.
4. Click Enable cookies.
5. Enter a unique path in which to store this application's cookies in the Cookie

path field and click OK. For example:
/WorkplaceXT

6. Select the Override session management option under General Properties and
click Apply.

7. Click Save directly to the master configuration.
8. Restart Workplace XT.
Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “Configuring and deploying IBM FileNet Workplace XT on a
WebSphere Application Server Network Deployment configuration” on page 48
Next topic: “(Optional) Configuring step processor locations for IBM ECM
Widgets”

(Optional) Configuring step processor locations for IBM ECM
Widgets

Complete this task only if your configuration uses IBM FileNet Content Manager
object stores and you want to configure step processors.

To configure step processor locations for IBM ECM Widgets:
1. Create the Business Space powered by WebSphere pages for your step

processor launch and steps, as appropriate for your configuration. For details
about configuring and integrating IBM FileNet P8 workflow applications and
step processor locations, see http://publib.boulder.ibm.com/infocenter/
p8docs/v4r5m1/topic/com.ibm.p8.doc/pe_help/config/
region_configure_step_processors.htm

2. Log on to IBM FileNet Workplace XT and navigate to Tools → Administration
→ Process Configuration Console.

3. Right-click the region you want to edit and choose Connect.
4. Right-click the region you want to edit and choose Properties.
5. Click the Step Processor Info tab.
6. Click the Add icon.
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7. Select the Type for the new entry from the dropdown menu.
8. Enter a name in the Name field.
9. Select HTML from the Language dropdown menu.

10. Double-click the Location field, then access the appropriate page URL for the
step processor and copy the #PID into the Location field. For example, select
the information in bold from the following URL and paste it into the Location
field:
http://localhost:9080/mum/resources/
bootstrap#pid=C0A876BCD8E8DACED43EB9E1F64E4C000012&

11. Repeat as appropriate for each step processor you want to configure.
12. Commit the changes.
Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “(Optional) Setting the IBM FileNet Workplace XT cookie path” on
page 50
Next topic: “Enable templates for Business Space powered by WebSphere”

Enable templates for Business Space powered by WebSphere
Templates for Business Space powered by WebSphere must be enabled on your
cluster to make them available for Business Space.

To enable templates for Business Space powered by WebSphere:
1. Open the oobLoadedStatus.properties on the node 1 server of your HA

configuration from the following location:
WAS_PROFILE_HOME\BusinessSpace\cluster_name\mm.runtime.prof\public

For example:
C:\IBM\WebSphere\AppServer1\profiles\AppSrv01\BusinessSpace
\mycluster\mm.runtime.prof\public\oobLoadedStatus.properties

2. Update the importTemplates.txt entry to true:
importTemplates.txt=true

3. Restart the deployment manager server computer, the node agent and the node
server.

4. Log into Business Space and verify that the templates are enabled.
Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “(Optional) Configuring step processor locations for IBM ECM
Widgets” on page 50
Next topic: “Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment”

Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment

Verify your configuration by accessing the URLs for each component.

To verify that IBM ECM Widgets and Business Space powered by WebSphere
deployed properly:
1. Open a browser from a remote computer and enter the following default

Business Space URL:
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Configuration URL

WebSphere Application Server http://host_server_name:port/mum/enabler

WebSphere Application Server Highly
Available (HA)

http://host_server_name/mum/enabler

2. Open a browser from a remote computer and enter the following default ECM
Widgets Version Information page URL:

Configuration URL

WebSphere Application Server http://host_server_name:port/ECMWidgets/
About.jsp

WebSphere Application Server Highly
Available (HA)

http://host_server_name/ECMWidgets/
About.jsp

The IBM ECM Widgets product is deployed to an instance of Business Space
powered by WebSphere on your server. You can now add IBM ECM Widgets to
Business Spaces and create new Business Space pages.

Parent topic: “Installing a Highly Available IBM WebSphere Application Server
Network Deployment of IBM ECM Widgets” on page 35
Previous topic: “Enable templates for Business Space powered by WebSphere” on
page 51
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Upgrading IBM ECM Widgets

The version of IBM WebSphere Application Server on your system determines
which method you will use to upgrade IBM ECM Widgets.

Depending on which version of IBM WebSphere Application Server you are
upgrading from, choose one of the following options:

Important: Once the IBM ECM Widgets V4.5.2 software upgrade is installed, you
cannot roll back to V4.5.1 of IBM ECM Widgets. If you want to return to the
previous version, you must uninstall V4.5.2 and run a new installation of IBM
ECM Widgets V4.5.1.

“Upgrading a WebSphere Application Server - Base installation of IBM ECM
Widgets V4.5.1”
“Upgrading an IBM WebSphere Application Server Network Deployment
Highly Available installation of IBM ECM Widgets V4.5.1” on page 64

Upgrading a WebSphere Application Server - Base installation of IBM
ECM Widgets V4.5.1

To upgrade an installation of IBM ECM Widgets 4.5.1 on IBM WebSphere
Application Server - Base, you must install WebSphere Application Server V7.0 and
Business Space powered by WebSphere V7.0 while the previous configuration is
still in place. Widgets information from your existing configuration can then be
migrated to the upgraded configuration.

To keep the same port numbers that you used for your IBM ECM Widgets 4.5.1
configuration, when you upgrade to V7.0 of WebSphere Application Server, you
can either create a new WebSphere Application Server profile or you can migrate
your existing WebSphere Application Server profile into the new installation of
WebSphere Application Server V7.0 to maintain your existing associated ports and
settings and your IBM FileNet Workplace XT configuration.

The method in which you will deploy V7.0 of Business Space powered by
WebSphere, depends on whether you choose to migrate your existing profile or
you choose to create a new profile and then reconfigure the IBM ECM Widgets
prerequisite software.
1. “Upgrading IBM ECM Widgets software” on page 54
2. “Upgrading the IBM WebSphere Application Server profile” on page 54
3. “Installing the Business Space powered by WebSphere installation package to

your WebSphere Application Server home directory” on page 57
4. “Deploying Business Space powered by WebSphere to the WebSphere

Application Server profile” on page 59
5. “Running the IBM ECM Widgets Configuration Manager” on page 60
6. “Migrating your IBM ECM Widgets V4.5.1 Business Space powered by

WebSphere database into the new configuration” on page 61
7. “Configuring migrated IBM ECM Widgets V4.5.1 step processor locations” on

page 63
8. “Verifying IBM ECM Widgets and Business Space powered by WebSphere

deployment” on page 63
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9. “Setting the IBM FileNet Workplace XT cookie path” on page 64
Parent topic: “Upgrading IBM ECM Widgets” on page 53

Upgrading IBM ECM Widgets software
Upgrading the IBM ECM Widgets software installs the components necessary to
deploy IBM ECM Widgets V4.5.2 and Business Space powered by WebSphere V7.0.

To upgrade IBM ECM Widgets software:
1. Log on to the host computer by using an account that has administrator

privileges.
2. Copy the installation package to the host computer.
3. Run the ECMWidgets4_5_2WIN.exe installation program.
4. Select the option to upgrade.
5. Review the pre-upgrade summary and click Install.
6. Review the Upgrade Complete summary. If errors occurred, see the log file in

the following default location: /opt/IBM/ECMWidgets
/IBM_ECM_Widgets_Install.log IBM ECM Widgets software is backed up to the
following directory during the upgrade:
C:\Program Files\IBM\ECMWidgets\backup\

CAUTION:
If you run the installation program again, all files in the backup location will
be overwritten with the current IBM ECM Widgets V4.5.2 information. If you
intend to run the installation program more than once, ensure you move your
IBM ECM Widgets V4.5.1 information from the backup location first.

Parent topic: “Upgrading a WebSphere Application Server - Base installation of
IBM ECM Widgets V4.5.1” on page 53
Next topic: “Upgrading the IBM WebSphere Application Server profile”

Upgrading the IBM WebSphere Application Server profile
When you upgrade the IBM WebSphere Application Server profile, you can
migrate the profile from your previous configuration and keep all of your existing
settings or you can delete the existing profile and create a new profile with the
same settings as your previous configuration.

“Upgrading from IBM ECM Widgets V4.5.1 by creating a new IBM WebSphere
Application Server V7.0 profile”
“Upgrading from IBM ECM Widgets V4.5.1 by migrating an existing
WebSphere Application Server profile” on page 55

Parent topic: “Upgrading a WebSphere Application Server - Base installation of
IBM ECM Widgets V4.5.1” on page 53
Previous topic: “Upgrading IBM ECM Widgets software”
Next topic: “Installing the Business Space powered by WebSphere installation
package to your WebSphere Application Server home directory” on page 57

Upgrading from IBM ECM Widgets V4.5.1 by creating a new IBM
WebSphere Application Server V7.0 profile
You can migrate your existing WebSphere Application Server profile and keep your
settings or you can delete your existing profile and create a new one with the same
settings.
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If you do not need to keep the profile from your previous installation of
WebSphere Application Server you can delete it and then install V7.0 of WebSphere
Application Server to a new location and create a new profile with the same port
settings.

If you want to keep the same port number settings but do not need to keep your
existing WebSphere Application Server profile settings, you can delete the existing
profile and then create a new WebSphere Application Server V7.0 profile. You will
then deploy Business Space powered by WebSphere V7.0 using the schema name
and database from your previous configuration. You must then reconfigure
WebSphere Application Server and reconfigure IBM FileNet P8 Workplace XT and
related components.

After the installation and reconfiguration is complete, you can then deploy IBM
ECM Widgets V4.5.2 to the new profile to complete the upgrade.
1. “Installing IBM WebSphere Application Server V7.0 and creating a new profile”
Parent topic: “Upgrading the IBM WebSphere Application Server profile” on page
54

Installing IBM WebSphere Application Server V7.0 and creating a new profile:

If you do not need to keep the WebSphere Application Server profile from your
previous installation IBM ECM Widgets, you can delete it and then install
WebSphere Application Server V7.0 to a new location and create a new profile with
the same configuration settings.

To install IBM WebSphere Application Server V7.0 and create a new profile:
1. Stop the server and delete the WebSphere Application Server profile from your

IBM Enterprise Content Management Widgets V4.5.1 configuration.
2. With the previous installation of WebSphere Application Server still in place,

install WebSphere Application Server V7.0 to a new location, for example:
C:\Program Files\IBM\WebSphere\AppServer1

3. Create a profile with the same name and port numbers as your previous
configuration in order to maintain your previous settings. Select Enable
Administrative Security on the Administrative Security page.

4. Install the appropriate maintenance package and appropriate SDK maintenance
package.

Parent topic: “Upgrading from IBM ECM Widgets V4.5.1 by creating a new IBM
WebSphere Application Server V7.0 profile” on page 54

Upgrading from IBM ECM Widgets V4.5.1 by migrating an
existing WebSphere Application Server profile
You can keep your existing IBM ECM Widgets WebSphere Application Server
configuration settings, including existing port numbers, LDAP settings and IBM
FileNet Workplace XT settings.

You can keep your existing IBM ECM Widgets WebSphere Application Server
configuration settings, including existing port numbers, LDAP settings and IBM
FileNet Workplace XT settings by migrating the existing profile to the new
installation of WebSphere Application Server V7.0. This method of upgrade is
accomplished by installing V7.0 of WebSphere Application Server while leaving
your existing installation in place. During the WebSphere Application Server V7.0
installation, you will specify the option to install without creating a new profile.
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After the installation is complete, you will run the WebSphere Application Server
Migration Wizard to migrate your old profile and IBM FileNet Workplace XT
configuration over to the new installation. Business Space powered by WebSphere
V7.0 and IBM ECM Widgets V4.5.2 can then be deployed.
1. “Removing deployed IBM ECM Widgets V4.5.1 applications”
2. “Installing IBM WebSphere Application Server V7.0 to migrate a V4.5.1 IBM

ECM Widgets profile”
3. “Migrating your IBM ECM Widgets V4.5.1 WebSphere Application Server

profile” on page 57
Parent topic: “Upgrading the IBM WebSphere Application Server profile” on page
54

Removing deployed IBM ECM Widgets V4.5.1 applications:

You must undeploy all applications from your previous installation.

To undeploy the IBM Enterprise Content Management Widgets applications from
IBM WebSphere Application Server V6.1:
1. Open the WebSphere Application Server administrative console and click

Applications → Enterprise Applications.
2. Select the following applications and click Uninstall:
v BusinessSpaceManager
v ECMWidgets
v IBM_BSPACE_WIDGETS

IBM ECM Widgets and Business Space powered by WebSphere have been
undeployed from the WebSphere Application Server.

3. Open the WebSphere Application Server administrative console and delete the
datasource with the JNDI name of jdbc/bpm/BusinessSpace which was used in
your previous IBM ECM Widgets configuration.

Parent topic: “Upgrading from IBM ECM Widgets V4.5.1 by migrating an existing
WebSphere Application Server profile” on page 55
Next topic: “Installing IBM WebSphere Application Server V7.0 to migrate a V4.5.1
IBM ECM Widgets profile”

Installing IBM WebSphere Application Server V7.0 to migrate a V4.5.1 IBM
ECM Widgets profile:

You must install IBM WebSphere Application Server V7.0 before you can migrate
your existing profile.

To install IBM WebSphere Application Server V7.0 and migrate an IBM ECM
Widgets V4.5.1 profile:
1. Run the appropriate V7.0 WebSphere Application Server installer and choose

the following settings:
v Install to a new location, for example: AppServer1.
v Ensure that you do not create a new profile during the installation. Select

None on the WebSphere Application Server Environments window and
confirm that you want to proceed without creating a profile.

v At the end of the installation, ensure that you clear the option to create a
new profile and click Finish.

2. Install the appropriate maintenance package and ensure that you select the new
installation location that you created in step 1.
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3. Install the appropriate SDK maintenance package and ensure that you select
the new installation location that you created in step 1.

Parent topic: “Upgrading from IBM ECM Widgets V4.5.1 by migrating an existing
WebSphere Application Server profile” on page 55
Previous topic: “Removing deployed IBM ECM Widgets V4.5.1 applications” on
page 56
Next topic: “Migrating your IBM ECM Widgets V4.5.1 WebSphere Application
Server profile”

Migrating your IBM ECM Widgets V4.5.1 WebSphere Application Server
profile:

You can migrate the profile you used for IBM ECM Widgets 4.5.1 to the new
installation of IBM WebSphere Application Server V7.0.

This will allow you to keep the same port numbers and related settings that you
used in IBM ECM Widgets 4.5.1. Using this approach, your IBM FileNet Workplace
XT configuration, and LDAP settings will also be migrated into the new profile.

To migrate your IBM WebSphere Application Server V6.1 profile from your IBM
ECM Widgets 4.5.1 configuration to IBM WebSphere Application Server V7.0:
1. Access the WebSphere Application Server administrative console and click

Applications → Application Types → WebSphere Enterprise Applications.
2. On Windows, click Start → All programs → IBM WebSphere → Application

Server V7.0 → Migration Wizard

3. Complete the wizard dialogs using the following settings:
v Select your WebSphere Application Server V6.1 installation for Existing

installations.
v Specify the WebSphere Application Server V6.1 profile as the Source profile

selection.
v Click <Create new profile> as the Target profile.
v Click Migrate and install the applications as the Application migration

settings option.
v Click Use the port values assigned to the previous (source) installation for

the Port value settings option.
4. Verify that the IBM FileNet Workplace XT application has migrated correctly by

setting the Class loader settings according to the instructions in the IBM FileNet
Workplace XT Installation and Upgrade Guide and then log into IBM FileNet
Workplace XT.

Parent topic: “Upgrading from IBM ECM Widgets V4.5.1 by migrating an existing
WebSphere Application Server profile” on page 55
Previous topic: “Installing IBM WebSphere Application Server V7.0 to migrate a
V4.5.1 IBM ECM Widgets profile” on page 56

Installing the Business Space powered by WebSphere
installation package to your WebSphere Application Server
home directory

Using IBM Installation Manager, you must install the Business Space package into
the WebSphere Application Server directory structure before you can deploy
Business Space.

Before you begin, ensure IBM Installation Manager V1.3.3 or later is installed.
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To run IBM Installation Manager and install the Business Space installation
package to the WebSphere Application Server home directory:
1. Start IBM Installation Manager.
2. Click File → Preferences.
3. In the Repositories window, click Add Repository.
4. In the Add a Repository window, click Browse. Browse to the BusinessSpace

directory within the IBM ECM Widgets installation location, select the
bscc.7000.repository.zip file and click OK. The file is installed in following
location:

Option Description

AIX ECMWidgets_Home/BusinessSpace/
bscc.7000.repository.zip

Windows ECMWidgets_Home\BusinessSpace\
bscc.7000.repository.zip

For example, the file is located in the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/
bscc.7000.repository.zip

Windows C:\Program Files\IBM\ECMWidgets\
BusinessSpace\bscc.7000.repository.zip

5. In the Add a Repository window, click Browse.
6. Browse to the BusinessSpace directory within the IBM ECM Widgets

installation location, select the bspace7.IFix.repository.zip file and click
OK. The file is installed in the following location:

Option Description

AIX ECMWidgets_Home/
bspace7.IFix.repository.zip

Windows ECMWidgets_Home\
bspace7.IFix.repository.zip

For example, the file is located in the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/
bspace7.IFix.repository.zip

Windows C:\Program Files\IBM\ECMWidgets
\BusinessSpace\
bspace7.IFix.repository.zip

7. In the Add a Repository window, click Browse.
8. Browse to the BusinessSpace directory within the IBM ECM Widgets

installation location, open the was-sync directory and select the
repository.config file. Click OK. The file is installed in the following
location:

Option Description

AIX ECMWidgets_Home/BusinessSpace/was-sync/
respository.config
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Option Description

Windows ECMWidgets_Home\BusinessSpace\was-sync\
repository.config

For example, the file is located in the following default path:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/was-
sync/respository.config

Windows C:\Program Files\IBM\ECMWidgets\
BusinessSpace\was-sync\repository.config

9. Click OK in the Repositories window.
10. Click the Import icon.
11. In the Import Existing WebSphere Installation window, click the Installation

Directory dropdown menu and select the appropriate WebSphere installation
directory, for example:

Option Description

AIX /opt/IBM/WebSphere/AppServer

Windows C:\ProgramFiles\IBM\WebSphere\AppServer

12. Click Next.
13. Specify a Shared Resources Directory and click Next.
14. Click Import.
15. Click Finish.
16. Click the Install icon.
17. In the Install Packages window, select the com.ibm.ws.bspace package and

click Next. The Install Packages window will display the package name and
installation directory you have selected.

18. Verify the information and then click Next. The Install Packages window will
display the package features that will be installed.

19. Click Next. The Install Packages window will display summary information
about the options you have selected.

20. Click Install.
21. Click Finish after the installation completes and then exit IBM Installation

Manager.
Parent topic: “Upgrading a WebSphere Application Server - Base installation of
IBM ECM Widgets V4.5.1” on page 53
Previous topic: “Upgrading the IBM WebSphere Application Server profile” on
page 54
Next topic: “Deploying Business Space powered by WebSphere to the WebSphere
Application Server profile”

Deploying Business Space powered by WebSphere to the
WebSphere Application Server profile

For IBM ECM Widgets upgrades, you must deploy Business Space powered by
WebSphere manually by running the WebSphere Application Server augment
command.
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To deploy Business Space powered by WebSphere to the WebSphere Application
Server profile:
1. From a command prompt, access the bin directory located in the WebSphere

Application Server installation home directory and run the following command
in one line:
manageprofiles -augment -profileName profileName -cellName
cellName -nodeName nodeName -templatePath
..\profileTemplates\BusinessSpace\default.bspace -enableAdminSecurity true
-adminUserName Admin_username -adminPassword
Admin_PWD -bspacedbDesign WAS_HOME/BusinessSpace/config.bspace/MetadataFiles

/BSpace_DB2-distributed.properties -dbDelayConfig false
-dbCreateNew true

For example, access C:\Program Files\IBM\WebSphere\AppServer\bin\ and
enter the following command in one line:
manageprofiles -augment -profileName AppSrv01 -nodeName myserverNode01
-cellName myserverNode01cell -templatePath ..\profileTemplates
\BusinessSpace\default.bspace -enableAdminSecurity true -adminUserName
administrator -adminPassword mypassword -bspacedbDesign C:/Progra~1
/IBM/WebSphere/AppServer/BusinessSpace/config.bspace/MetadataFiles
/BSpace_DB2-distributed.properties -dbDelayConfig false -dbCreateNew true

Restriction: The command must complete with the following result to have
been successful:
INSTCONFSUCCESS: Profile augmentation succeeded

If you did not receive the correct result, investigate the log files, as indicated by
the command result.

2. Enable application security by entering the following command:
wsadmin -username username -password password -conntype NONE
-lang jython -c "AdminTask.setAdminActiveSecuritySettings
('[-appSecurityEnabled true]')"

Parent topic: “Upgrading a WebSphere Application Server - Base installation of
IBM ECM Widgets V4.5.1” on page 53
Previous topic: “Installing the Business Space powered by WebSphere installation
package to your WebSphere Application Server home directory” on page 57
Next topic: “Running the IBM ECM Widgets Configuration Manager”

Running the IBM ECM Widgets Configuration Manager
Run the Configuration Manager to deploy the upgraded version of IBM ECM
Widgets on your IBM WebSphere Application Server profile and configure the
necessary settings.

Gather the following information before you start the deployment:
v IBM WebSphere Application Server settings:

– Home directory path
– Profile name
– Administrator log on credentials
– SOAP Connector address port

v IBM FileNet Workplace XT settings:
– Workplace XT installation path
– Process Engine REST API URL
– Content Engine services URL
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To deploy ECM Widgets on WebSphere Application Server:
1. Start the IBM WebSphere Application Server.
2. Launch the IBM ECM Widgets Configuration Manager:
3. Click Start → All Programs → IBM ECM Widgets → Configuration Manager.
4. Follow the instructions on the IBM ECM Widgets Configuration Manager

screens and enter the required details about your configuration.
5. Click Finish to complete the deployment.
6. If any errors occurred, review the configuration log for details. Run the IBM

ECM Widgets Configuration Manager again. The log is located in the following
default location:
C:\Program Files\IBM\ECMWidgets\logs

Tip: For configurations that use IBM FileNet Content Manager object stores,
the IBM ECM Widgets configuration manager rebuilt the IBM FileNet
Workplace XT WAR and EAR files.

7. (optional) Enable the ecmX theme. As part of the IBM ECM Widgets
installation, a new Business Space theme was installed. In order to make this
theme available to end users, you must enable it using the following procedure.

Note: To enable this style later, a restart of WebSphere Application Server will
be necessary.
a. Click Servers → Server Types → WebSphere application servers.
b. Click on the server where Business Space is deployed.
c. Click Java and Process Management → Process Definition → Environment

Entries.
d. Click New to create a new Environment Entry.
e. Enter BSPACE_STYLE_EXT_DIR in the Name field.
f. Enter the path to the styles folder in your IBM ECM Widgets installation

directory. For example, the folder is located in the following default location:

Option Description

AIX /opt/IBM/ECMWidgets/BusinessSpace/styles

Windows C:\Program Files\IBM\ECMWidgets\
BusinessSpace\styles

g. Click Apply and then click Save directly to the master configuration.
8. Stop and restart the IBM WebSphere Application Server.
9. Restart the Process WPXT Services Manager process according to the

instructions in the IBM FileNet Workplace XT Installation and Upgrade Guide.
Parent topic: “Upgrading a WebSphere Application Server - Base installation of
IBM ECM Widgets V4.5.1” on page 53
Previous topic: “Deploying Business Space powered by WebSphere to the
WebSphere Application Server profile” on page 59
Next topic: “Migrating your IBM ECM Widgets V4.5.1 Business Space powered by
WebSphere database into the new configuration”

Migrating your IBM ECM Widgets V4.5.1 Business Space
powered by WebSphere database into the new configuration

You must reuse the database from your previous configuration by migrating it into
the upgraded configuration.
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The following data will be migrated:
v database
v spaces
v pages
v styles
v widget wiring information

To migrate your IBM ECM Widgets V4.5.1 Business Space powered by WebSphere
database into the new configuration:
1. Access the BusinessSpace directory in your WebSphere profile home directory.

Create a new directory called datamigration and then create a subdirectory
within called widgets. For example:
C:\Program Files\IBM\WebSphere\AppServer\profiles\AppSrv01
\BusinessSpace\datamigration\widgets\

2. Access the iwidget directory in the following path of the WebSphere home
directory where you deployed IBM ECM Widgets:
WAS_HOME\profiles\AppSrv\installedApps\Node_Name
\ECMWidgets.ear\ECMWidgets.war\catalog\com\ibm\im\ecmwidgets\iwidget

3. Copy the XML files from the iwidgets directory into the new
datamigration\widgets directory you created. For example, copy Header.xml,
Inbasket.xml and all other XML files from:
C:\Program Files\IBM\WebSphere\AppServer\profiles\AppSrv01\installedApps
\MyServerNode01Cell\ECMWidgets.ear\ECMWidgets.war\catalog\com\ibm\im
\ecmwidgets\iwidget

Paste the files into the following directory:
C:\Program Files\IBM\WebSphere\AppServer\profiles\AppSrv01
\BusinessSpace\datamigration\widgets\

4. Start the WebSphere Application Server profile.
5. From a command line, access the scripts directory in the WebSphere

Application Server home directory. For example:
C:\Program files\IBM\WebSphere\AppServer\BusinessSpace\scripts

6. Enter the following command in one line to migrate the IBM ECM Widgets
data:
migrateBSpaceData.bat -host hostname -port SOAP_PORT -user Admin_User
-password Admin_Pwd -cluster cluster_Name

For example:
migrateBSpaceData.bat -host localhost -port 8880 -user administrator
-password mypassword -cluster mycluster

7. Verify the data migration by reviewing the logs in the following locations:
v WAS_HOME\logs\bspace\BusinessSpaceDataMigration.log

v WAS_PROFILE_HOME\logs\server\SystemErr.log

v WAS_PROFILE_HOME\logs\server\SystemOut.log
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Parent topic: “Upgrading a WebSphere Application Server - Base installation of
IBM ECM Widgets V4.5.1” on page 53
Previous topic: “Running the IBM ECM Widgets Configuration Manager” on page
60
Next topic: “Configuring migrated IBM ECM Widgets V4.5.1 step processor
locations”

Configuring migrated IBM ECM Widgets V4.5.1 step processor
locations

Step processors created for IBM ECM Widgets V4.5.1 must be modified before they
can be used for IBM ECM Widgets V4.5.2.

To modify step processor locations for IBM ECM Widgets V4.5.2:
1. Log on to IBM FileNet Workplace XT and navigate to Tools → Administration →

Process Configuration Console.
2. Right-click the region you want to edit and choose Connect.
3. Right-click the region you want to edit and choose Properties.
4. Click the Step Processor Info tab.
5. For each IBM ECM Widgets V4.5.1 step processor that you want to use in IBM

ECM Widgets V4.5.2, modify the IBM ECM Widgets for Business Space Web
Application Location field data as follows:
a. On the Step Processor Info tab, double-click the Location field.
b. Edit the IBM ECM Widgets for Business Space Web Application Location

field. From the entry in the field, delete spaceID= and all following
characters, up to and including pageID=. This will leave only the page ID
value in the field. For example, in the following entry, delete all the
non-bold characters and leave only the bold characters:
spaceId=c51676b061a711deabd4fbec886409ec
&pageId=1245951012739_d6b92d3061ad11de87c7fb510db2aa38

6. Commit the changes.
Parent topic: “Upgrading a WebSphere Application Server - Base installation of
IBM ECM Widgets V4.5.1” on page 53
Previous topic: “Migrating your IBM ECM Widgets V4.5.1 Business Space powered
by WebSphere database into the new configuration” on page 61
Next topic: “Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment”

Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment

Verify your configuration by accessing the URLs for each component.

To verify that IBM ECM Widgets and Business Space powered by WebSphere
deployed properly:
1. Open a browser from a remote computer and enter the following default

Business Space URL:

Configuration URL

WebSphere Application Server http://host_server_name:port/mum/enabler

WebSphere Application Server Highly
Available (HA)

http://host_server_name/mum/enabler
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2. Open a browser from a remote computer and enter the following default ECM
Widgets Version Information page URL:

Configuration URL

WebSphere Application Server http://host_server_name:port/ECMWidgets/
About.jsp

WebSphere Application Server Highly
Available (HA)

http://host_server_name/ECMWidgets/
About.jsp

The IBM ECM Widgets product is deployed to an instance of Business Space
powered by WebSphere on your server. You can now add IBM ECM Widgets to
Business Spaces and create new Business Space pages.

Parent topic: “Upgrading a WebSphere Application Server - Base installation of
IBM ECM Widgets V4.5.1” on page 53
Previous topic: “Configuring migrated IBM ECM Widgets V4.5.1 step processor
locations” on page 63
Next topic: “Setting the IBM FileNet Workplace XT cookie path”

Setting the IBM FileNet Workplace XT cookie path
You must enable cookies and set a unique cookie path for your configuration.

To set the IBM FileNet Workplace XT cookie path:
1. Access the WebSphere Application Server administrative console and click

Applications → Application Types → WebSphere Enterprise Applications.
2. Click Workplace XT.
3. Click Session management under Web Module Properties.
4. Click Enable cookies.
5. Enter a unique path in which to store this application's cookies in the Cookie

path field and click OK. For example:
/WorkplaceXT

6. Select the Override session management option under General Properties and
click Apply.

7. Click Save directly to the master configuration.
8. Restart Workplace XT.
Parent topic: “Upgrading a WebSphere Application Server - Base installation of
IBM ECM Widgets V4.5.1” on page 53
Previous topic: “Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment” on page 63

Upgrading an IBM WebSphere Application Server Network Deployment
Highly Available installation of IBM ECM Widgets V4.5.1

To upgrade IBM ECM Widgets V4.5.1, you must install IBM WebSphere
Application Server Network Deployment V7.0 and Business Space powered by
WebSphere V7.0 while the previous configuration is still in place.

To upgrade an IBM WebSphere Application Server Network Deployment Highly
Available installation of IBM ECM Widgets V4.5.1, you must install WebSphere
Application Server Network Deployment V7.0 and Business Space powered by
WebSphere V7.0 while the previous installation of WebSphere Application Server
Network Deployment is still in place. IBM ECM Widgets information from your
existing configuration can then be migrated to the upgraded configuration and the
upgraded product can then be deployed.
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1. “Installing prerequisite software”
2. “Installing IBM ECM Widgets on the WebSphere Application Server Network

Deployment configuration” on page 66
3. “Installing the Business Space powered by WebSphere installation package to

your WebSphere Application Server Network Deployment configuration” on
page 66

4. “Preparing a database for IBM DB2 for Linux, UNIX and Windows” on page
68

5. “Configuring the WebSphere Application Server Network Deployment
deployment manager profile for Business Space powered by WebSphere” on
page 68

6. “Creating a data source for a WebSphere Application Server Network
Deployment V7.0 upgraded IBM ECM Widgets configuration” on page 69

7. “Deploying Business Space powered by WebSphere on the WebSphere
Application Server Network Deployment configuration” on page 70

8. “Deploying IBM ECM Widgets on a WebSphere Application Server Network
Deployment configuration” on page 71

9. “Migrating your IBM ECM Widgets V4.5.1 Business Space powered by
WebSphere database into the new configuration” on page 72

10. “Configuring and deploying IBM FileNet Workplace XT on a WebSphere
Application Server Network Deployment configuration” on page 73

11. “Configuring migrated IBM ECM Widgets V4.5.1 step processor locations” on
page 74

12. “Enable templates for Business Space powered by WebSphere” on page 75
13. “Verifying IBM ECM Widgets and Business Space powered by WebSphere

deployment” on page 75
14. “Setting the IBM FileNet Workplace XT cookie path” on page 76
Parent topic: “Upgrading IBM ECM Widgets” on page 53

Installing prerequisite software
You must upgrade the WebSphere Application Server Network Deployment
software on all servers in your clustered environment before you can upgrade your
IBM ECM Widgets software.

To upgrade an IBM WebSphere Application Server Network Deployment Highly
Available installation of IBM ECM Widgets V4.5.1:
1. Upgrade all servers in your clustered environment to WebSphere Application

Server Network Deployment V7.0 while the previous installation is still in
place.

2. Create a WebSphere Application Server Network Deployment V7.0 clustered
environment. For details on creating and configuring a clustered environment,
see the WebSphere Application Server Network Deployment online information
center: http://publib.boulder.ibm.com/infocenter/wasinfo/v7r0/
index.jsp?topic=/com.ibm.websphere.nd.doc/info/ae/ae/welcome_nd.html
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Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Next topic: “Installing IBM ECM Widgets on the WebSphere Application Server
Network Deployment configuration”

Installing IBM ECM Widgets on the WebSphere Application
Server Network Deployment configuration

Install IBM ECM Widgets on the deployment manager and each node of your
WebSphere Application Server Network Deployment cluster.

To install IBM ECM Widgets on the WebSphere Application Server Network
Deployment configuration:
1. Log on to the host computer by using an account that has administrator

privileges.
2. Copy the installation package to the host computer.
3. Access the installation package and run the ECMWidgets4_5_2WIN.exe

installation program.
4. In the Specify Installation Options window, select one or both of the following

installation options:
v Install IBM ECM Widgets on this computer to install the product.
v Save your settings in a response file to record the options that you select

during this installation in a file. The response file can be used to silently
install the product on another computer that will use the same settings that
you select during this installation.

5. Specify a directory in which to install the software:
v To accept the default installation path, click Next.
v To repopulate the field with the default installation path, click Restore

Default Folder.
v To navigate to a different installation path, click Choose and browse for the

directory you want to use.
6. Review the pre-installation summary and click Install.
7. Review the installation summary. If errors occurred, see the log file in the

following default location:
C:\Program Files\IBM\ECMWidgets\IBM_ECM_Widgets_Install.log

Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Installing prerequisite software” on page 65
Next topic: “Installing the Business Space powered by WebSphere installation
package to your WebSphere Application Server Network Deployment
configuration”

Installing the Business Space powered by WebSphere
installation package to your WebSphere Application Server
Network Deployment configuration

Install the Business Space powered by WebSphere installation package to the
deployment manager and each node of your WebSphere Application Server
Network Deployment cluster.

Ensure IBM Installation Manager V1.3.3 or later is installed.
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To install the Business Space powered by WebSphere installation package to your
WebSphere Application Server Network Deployment configuration:
1. Log on to the deployment manager computer by using an account that has

administrator privileges.
2. Start IBM Installation Manager.
3. Click File → Preferences.
4. In the Repositories window, click Add Repository.
5. In the Add a Repository window, click Browse.
6. Browse to the IBM ECM Widgets installation directory, select the

bscc.7000.repository.zip file from the BusinessSpace directory, and click
OK. For example: C:\Progam Files\IBM\ECMWidgets\BusinessSpace\
bscc.7000.repository.zip

7. Browse to the BusinessSpace directory within the IBM ECM Widgets
installation location, select the bspace7.IFix.repository.zip file and click
OK. The file is installed in the following location:
ECMWidgets_Home\bspace7.IFix.repository.zip

For example, the file is located in the following default path:
C:\Program Files\IBM\ECMWidgets \BusinessSpace\bspace7.IFix.repository.zip

8. In the Add a Repository window, click Browse.
9. Browse to the BusinessSpace directory within the IBM ECM Widgets

installation location, open the was-sync directory and select the
repository.config file. Click OK. The file is installed in the following
location:
ECMWidgets_Home\BusinessSpace\was-sync\repository.config

For example, the file is located in the following default path:
C:\Program Files\IBM\ECMWidgets\BusinessSpace\was-sync\repository.config

10. Click OK on the Repositories window.
11. Click the Import icon.
12. In the Import Existing WebSphere Installation window, click the Installation

Directory dropdown menu and select the appropriate WebSphere installation
directory. For example: C:\Program Files\IBM\WebSphere\AppServer

13. Click Next.
14. Specify a Shared Resources Directory and click Next.
15. Click Import.
16. Click Finish.
17. Click the Install icon.
18. In the Install Packages window, select the com.ibm.ws.bspace package and

click Next. The Install Packages window will display the package name and
installation directory you have selected.

19. Verify the information and then click Next. The Install Packages window will
display the package features that will be installed.

20. Click Next. The Install Packages window will display summary information
about the options you have selected.

21. Click Install.
22. Click Finish after the installation completes and then exit IBM Installation

Manager.
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Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Installing IBM ECM Widgets on the WebSphere Application
Server Network Deployment configuration” on page 66
Next topic: “Preparing a database for IBM DB2 for Linux, UNIX and Windows”

Preparing a database for IBM DB2 for Linux, UNIX and
Windows

If DB2 is remote from the IBM ECM Widgets installation, you must create an
empty database and modify a properties file.

To prepare an IBM DB2 for Linux, UNIX and Windows database for Business
Space powered by WebSphere:
1. Create a copy of the BSpace_DB2-distributed.properties template file and save

it to a new location. The file is installed in the following location:
WAS_home\BusinessSpace\config.bspace\MetadataFiles\

For example, copy the file from:
C:\Program Files\IBM\WebSphere\AppServer\BusinessSpace\config.bspace
\MetadataFiles\BSpace_DB2-distributed.properties

Save the file to:C:\BSpace_DB2-distributed.properties
2. Open the copy of the BSpace_DB2-distributed.properties file in a text editor

and, using the instructions within, edit the appropriate values.
Attention: If Program Files is part of your temporary path location, it must
be entered as:
C:/Progra~1/

3. Save and close the file.
Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Installing the Business Space powered by WebSphere installation
package to your WebSphere Application Server Network Deployment
configuration” on page 66
Next topic: “Configuring the WebSphere Application Server Network Deployment
deployment manager profile for Business Space powered by WebSphere”

Configuring the WebSphere Application Server Network
Deployment deployment manager profile for Business Space
powered by WebSphere

The deployment manager profile for your cluster must be configured for Business
Space by running the augment command.

To configure the WebSphere Application Server Network Deployment deployment
manager profile for Business Space powered by WebSphere:
1. Log on to the deployment manager using an account that has administrator

privileges.
2. From a command prompt, access the bin directory located in the WebSphere

Application Server Network Deployment root directory and run the following
command:
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manageprofiles -augment -profileName DmgrProfile -nodeName
DmgrHostnameCellManagerCellMgrNum -cellName DmgrHostnameCellCelNum
-templatePath ../profileTemplates/BusinessSpace/dmgr.bspace
-enableAdminSecurity true -adminUserName administrator -adminPassword
AdminPwd -bspacedbDesign WAS_Home/BusinessSpace/config.bspace
/MetadataFiles/BSpace_DB2-distributed.properties -dbDelayConfig false
-dbCreateNew true

For example, access C:\Program Files\IBM\WebSphere\AppServer\bin\ and run
the following command:
manageprofiles -augment -profileName Dmgr01 -nodeName DmgrHostCellManager01
-cellName DmgrHostCell01 -templatePath ../profileTemplates/BusinessSpace
/dmgr.bspace -enableAdminSecurity true -adminUserName administrator
-adminPassword myPassword -bspacedbDesign C:/Progra~1/IBM/WebSphere
/AppServer/BusinessSpace/config.bspace/MetadataFiles
/BSpace_DB2-distributed.properties -dbDelayConfig false -dbCreateNew true

Restriction: The command must complete with the following result to have
been successful:
INSTCONFSUCCESS: Profile augmentation succeeded

If you did not receive the correct result, investigate the log files, as indicated by
the command result.

Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Preparing a database for IBM DB2 for Linux, UNIX and
Windows” on page 68
Next topic: “Creating a data source for a WebSphere Application Server Network
Deployment V7.0 upgraded IBM ECM Widgets configuration”

Creating a data source for a WebSphere Application Server
Network Deployment V7.0 upgraded IBM ECM Widgets
configuration

You must create a new data source and JDBC provider, based on the database used
for your previous IBM ECM Widgets V4.5.1 configuration.

To create a WebSphere Application Server Network Deployment data source:
1. Open the WebSphere Application Server Network Deployment Integrated

Solutions console.
2. Navigate to Resources → JDBC → Data Sources.
3. Select the cluster from the Scopes menu.
4. Click New on the Data sources page.
5. Enter a name for the data source in the Data source name field.
6. Enter jdbc/mashupDS in the JNDI name field and click Next.

7. Click Create new JDBC provider and click Next on the Select JDBC provider
page.

8. Select the following options on the Create new JDBC Provider page and click
Next:
v DB2 in the Database type field
v DB2 Universal JDBC Driver Provider in the Provider type field
v XA data source in the Implementation type field
v DB2 Universal JDBC Driver Provider (XA) (default) in the Name field

9. Enter the paths to the JDBC drivers and click Next. For example:
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v C:\Program Files\IBM\SQLLIB\java for the
DB2UNIVERSAL_JDBC_DRIVER_PATH

v C:\Program Files\IBM\SQLLIB\lib for the DB2UNIVERSAL_JDBC_DRIVER
_NATIVEPATH

10. Enter the following information on the Enter database-specific properties for
the data source page and click Next:
v Value of 4 for the Driver type
v The name of the IBM ECM Widgets V4.5.1 database in the Database name

field
v localhost for the Server name field
v Accept the default Port number

11. Click Next on the Setup security aliases page.
12. Review the information on the Summary page and click Finish.
13. Click Save directly to the master configuration.
14. Access Resources → JDBC → Data sources and click on the new data source

you created.
15. click JAAS - J2C authentication data and then click New on the JAAS - J2C

authentication data page.
16. Enter an alias and authentication information and click OK.
17. Click Save directly to the master configuration.
18. Access Resources → JDBC → Data sources and click on the new data source

you created.
19. Scroll down to Security settings, select the authentication alias you just created

from the dropdown list below Component-managed authentication alias and
click OK.

20. Click Save directly to the master configuration.
21. Restart the deployment manager server and all nodes.
22. Verify the connection to the data source that you created:

a. Open the WebSphere Application Server administrative console.
b. Access Resources → JDBC → Data Sources

c. Select the data source that you created and click Test connection. A
WebSphere Application Server message indicates whether connection to
the data source was successful.

Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Configuring the WebSphere Application Server Network
Deployment deployment manager profile for Business Space powered by
WebSphere” on page 68
Next topic: “Deploying Business Space powered by WebSphere on the WebSphere
Application Server Network Deployment configuration”

Deploying Business Space powered by WebSphere on the
WebSphere Application Server Network Deployment
configuration

Business Space powered by WebSphere must be deployed manually on the
WebSphere Application Server Network Deployment configuration.

To deploy Business Space powered by WebSphere on the WebSphere Application
Server Network Deployment configuration:
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1. Log on to the deployment manager computer by using an account that has
administrator privileges.

2. From a command prompt, access the bin directory located in the WebSphere
Application Server Network Deployment root directory:
C:\Program Files\IBM\WebSphere\AppServer\bin\

3. Access the wsadmin command prompt by entering the following command:
wsadmin.bat -conntype NONE

4. Enter the following command to deploy Business Space to the deployment
manager profile:
$AdminTask installBusinessSpace {-clusterName ClusterName}

For example:
$AdminTask installBusinessSpace {-clusterName myCluster}

5. Enter the following command:
$AdminConfig save

6. Configure Business Space on the deployment manager, enter the following
command from the wsadmin command prompt:
$AdminTask configureBusinessSpace {-clusterName ClusterName -schemaName BSPACE
-tableSpaceName BSPACE -storageGroup BSPACE}

For example:
$AdminTask configureBusinessSpace {-clusterName myCluster -schemaName
BSPACE -tableSpaceName BSPACE -storageGroup BSPACE}

7. Enter the following command:
$AdminConfig save

Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Creating a data source for a WebSphere Application Server
Network Deployment V7.0 upgraded IBM ECM Widgets configuration” on page 69
Next topic: “Deploying IBM ECM Widgets on a WebSphere Application Server
Network Deployment configuration”

Deploying IBM ECM Widgets on a WebSphere Application
Server Network Deployment configuration

You must manually deploy IBM ECM Widgets to your cluster.

Ensure IBM FileNet Workplace XT and related REST services are installed.

To deploy IBM ECM Widgets to the cluster:
1. Log on to the host computer using an account that has administrator privileges.
2. From a command prompt, access the bin directory located in the WebSphere

Application Server Network Deployment Deployment Manager profile root
directory and run the following command to access the wsadmin command
prompt:
wsadmin -conntype NONE

For example, run the command from the following directory:
C:\Program Files\IBM\WebSphere\AppServer\bin\

3. At the wsadmin command prompt, enter the following command in one line:
$AdminTask installBusinessSpaceWidgets {-clusterName cluster_name -widgets widgets_home
\Widgets_ECMWidgetsP8.zip}

For example:
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$AdminTask installBusinessSpaceWidgets {-clusterName myCluster -widgets
C:\Program Files\IBM\Widgets_ECMWidgetsP8.zip}

4. Enter $AdminConfig save

5. Adjust the settings in the bootstrap.json file, as appropriate for your
configuration. For details on modifying IBM ECM Widgets configuration
settings, see “Modifying IBM Enterprise Content Management Widgets
configuration settings” on page 77.

Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Deploying Business Space powered by WebSphere on the
WebSphere Application Server Network Deployment configuration” on page 70
Next topic: “Migrating your IBM ECM Widgets V4.5.1 Business Space powered by
WebSphere database into the new configuration”

Migrating your IBM ECM Widgets V4.5.1 Business Space
powered by WebSphere database into the new configuration

You must reuse the database from your previous configuration by migrating it into
the upgraded configuration.

The following data will be migrated:
v database
v spaces
v pages
v styles
v widget wiring information

To migrate your IBM ECM Widgets V4.5.1 Business Space powered by WebSphere
database into the new configuration:
1. Access the database scripts located in

DMGR_PROFILE_HOME\dbscripts\BusinessSpace\clusterName\DB2\databaseName

For example:
C:\IBM\WebSphere\AppServer\profiles\Dmgr01\dbscripts\BusinessSpace
\mycluster\DB2\bspacedb

2. Copy the scripts to the DB2 server. Execute the following scripts on the
Business Space database from your IBM ECM Widgets V4.5.1 configuration:
v createTablespace.sql

v createTable.sql

v createTables_BusinessSpace.sql

3. Access the BusinessSpace directory in your WebSphere profile home directory.
Create a new directory called datamigration and then create a subdirectory
within called widgets. For example:
C:\Program Files\IBM\WebSphere\AppServer\profiles\AppSrv01
\BusinessSpace\datamigration\widgets\

4. Access the iwidget directory in the following path of the WebSphere home
directory where you deployed IBM ECM Widgets:
WAS_HOME\profiles\AppSrv\installedApps\Node_Name
\ECMWidgets.ear\ECMWidgets.war\catalog\com\ibm\im\ecmwidgets\iwidget

5. Copy the XML files from the iwidgets directory into the new
datamigration\widgets directory you created. For example, copy Header.xml,
Inbasket.xml and all other XML files from:
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C:\Program Files\IBM\WebSphere\AppServer\profiles\AppSrv01\installedApps
\MyServerNode01Cell\ECMWidgets.ear\ECMWidgets.war\catalog\com\ibm\im
\ecmwidgets\iwidget

Paste the files into the following directory:
C:\Program Files\IBM\WebSphere\AppServer\profiles\AppSrv01
\BusinessSpace\datamigration\widgets\

6. Start the WebSphere Application Server profile.
7. From a command line, access the scripts directory in the WebSphere

Application Server home directory. For example:
C:\Program files\IBM\WebSphere\AppServer\BusinessSpace\scripts

8. Enter the following command in one line to migrate the IBM ECM Widgets
data:
migrateBSpaceData.bat -host hostname -port SOAP_PORT -user Admin_User
-password Admin_Pwd -cluster cluster_Name

For example:
migrateBSpaceData.bat -host localhost -port 8880 -user administrator
-password mypassword -cluster mycluster

9. Verify the data migration by reviewing the logs in the following locations:
v WAS_HOME\logs\bspace\BusinessSpaceDataMigration.log

v WAS_PROFILE_HOME\logs\server\SystemErr.log

v WAS_PROFILE_HOME\logs\server\SystemOut.log
Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Deploying IBM ECM Widgets on a WebSphere Application Server
Network Deployment configuration” on page 71
Next topic: “Configuring and deploying IBM FileNet Workplace XT on a
WebSphere Application Server Network Deployment configuration”

Configuring and deploying IBM FileNet Workplace XT on a
WebSphere Application Server Network Deployment
configuration

To deploy Workplace XT on a WebSphere Application Server Network Deployment
configuration, the product must be installed on the deployment manager and
cluster nodes.

To configure and deploy IBM FileNet Workplace XT on a WebSphere Application
Server Network Deployment system:
1. Log on to the deployment manager computer using an account that has

administrator privileges.
2. In a text editor, open the web.xml file from the WEB-INF directory in the IBM

FileNet Workplace XT installation location. For example: C:\Program
Files\IBM\FileNet\WebClient\WorkplaceXT\WEB-INF

3. Locate the <servlet> entries section and add the following entries:
<servlet>

<servlet-name>P8CERESTServlet</servlet-name>
<servlet-class>com.ibm.im.ecmwidgets.rest.P8CERESTServlet</servlet-class>

</servlet>
<servlet>

<servlet-name>ecmWidgetForm</servlet-name>
<servlet-class>com.filenet.eforms.apps.server.servlet.ECMWidgetFormServlet

</servlet-class>
</servlet>
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4. Locate the <servlet-mapping> entries section and add the following entries:
<servlet-mapping>

<servlet-name>ecmWidgetForm</servlet-name>
<url-pattern>/ecmWidgetForm/*</url-pattern>

</servlet-mapping>
<servlet-mapping>

<servlet-name>P8CERESTServlet</servlet-name>
<url-pattern>/P8CEREST/*</url-pattern>

</servlet-mapping>

5. Copy the ceREST.jar file from the lib directory in the IBM ECM Widgets
installation location. For example: C:\Program Files\IBM\ECMWidgets\
ContentList\lib\ceREST.jar

Save the file to the lib directory in the Workplace XT installation location. For
example: C:\Program Files\IBM\FileNet\WebClient\WorkplaceXT\WEB-INF\lib\
ceREST.jar

6. Copy the ECMWidgetFormServlet.jar file from the IBM ECM Widgets
installation location. For example: C:\Program Files\IBM\ECMWidgets\eForms\
ECMWidgetFormServlet.jar

Save the file to the lib directory in the Workplace XT installation location. For
example: C:\Program Files\IBM\FileNet\WebClient\WorkplaceXT\WEB-INF\lib\
ECMWidgetFormServlet.jar

7. Recreate the Workplace XT WAR and EAR files and deploy Workplace XT. For
details, see the IBM FileNet Workplace XT Installation and Upgrade Guide
which can be downloaded from the IBM Web site Product Documentation for
FileNet P8 Platform support page at the following location:
http://www.ibm.com/support/docview.wss?rs=3278&amp;uid=swg27010422.
Use the following options which are unique to deploying on a WebSphere
Application Server Network Deployment configuration:
v Select the CellManager as the node name that contains your Workplace XT

application.
v Choose Detailed - Show all installation options and parameters on the

Preparing for the application installation page.
v On the Map modules to servers page, select the cluster, the web server and

the application and then click Apply.
Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Migrating your IBM ECM Widgets V4.5.1 Business Space powered
by WebSphere database into the new configuration” on page 72
Next topic: “Configuring migrated IBM ECM Widgets V4.5.1 step processor
locations”

Configuring migrated IBM ECM Widgets V4.5.1 step processor
locations

Step processors created for IBM ECM Widgets V4.5.1 must be modified before they
can be used for IBM ECM Widgets V4.5.2.

To modify step processor locations for IBM ECM Widgets V4.5.2:
1. Log on to IBM FileNet Workplace XT and navigate to Tools → Administration →

Process Configuration Console.
2. Right-click the region you want to edit and choose Connect.
3. Right-click the region you want to edit and choose Properties.
4. Click the Step Processor Info tab.
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5. For each IBM ECM Widgets V4.5.1 step processor that you want to use in IBM
ECM Widgets V4.5.2, modify the IBM ECM Widgets for Business Space Web
Application Location field data as follows:
a. On the Step Processor Info tab, double-click the Location field.
b. Edit the IBM ECM Widgets for Business Space Web Application Location

field. From the entry in the field, delete spaceID= and all following
characters, up to and including pageID=. This will leave only the page ID
value in the field. For example, in the following entry, delete all the
non-bold characters and leave only the bold characters:
spaceId=c51676b061a711deabd4fbec886409ec
&pageId=1245951012739_d6b92d3061ad11de87c7fb510db2aa38

6. Commit the changes.
Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Configuring and deploying IBM FileNet Workplace XT on a
WebSphere Application Server Network Deployment configuration” on page 73
Next topic: “Enable templates for Business Space powered by WebSphere”

Enable templates for Business Space powered by WebSphere
Templates for Business Space powered by WebSphere must be enabled on your
cluster to make them available for Business Space.

To enable templates for Business Space powered by WebSphere:
1. Open the oobLoadedStatus.properties on the node 1 server of your HA

configuration from the following location:
WAS_PROFILE_HOME\BusinessSpace\cluster_name\mm.runtime.prof\public

For example:
C:\IBM\WebSphere\AppServer1\profiles\AppSrv01\BusinessSpace
\mycluster\mm.runtime.prof\public\oobLoadedStatus.properties

2. Update the importTemplates.txt entry to true:
importTemplates.txt=true

3. Restart the deployment manager server computer, the node agent and the node
server.

4. Log into Business Space and verify that the templates are enabled.
Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Configuring migrated IBM ECM Widgets V4.5.1 step processor
locations” on page 74
Next topic: “Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment”

Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment

Verify your configuration by accessing the URLs for each component.

To verify that IBM ECM Widgets and Business Space powered by WebSphere
deployed properly:
1. Open a browser from a remote computer and enter the following default

Business Space URL:
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Configuration URL

WebSphere Application Server http://host_server_name:port/mum/enabler

WebSphere Application Server Highly
Available (HA)

http://host_server_name/mum/enabler

2. Open a browser from a remote computer and enter the following default ECM
Widgets Version Information page URL:

Configuration URL

WebSphere Application Server http://host_server_name:port/ECMWidgets/
About.jsp

WebSphere Application Server Highly
Available (HA)

http://host_server_name/ECMWidgets/
About.jsp

The IBM ECM Widgets product is deployed to an instance of Business Space
powered by WebSphere on your server. You can now add IBM ECM Widgets to
Business Spaces and create new Business Space pages.

Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Enable templates for Business Space powered by WebSphere” on
page 75
Next topic: “Setting the IBM FileNet Workplace XT cookie path”

Setting the IBM FileNet Workplace XT cookie path
You must enable cookies and set a unique cookie path for your configuration.

To set the IBM FileNet Workplace XT cookie path:
1. Access the WebSphere Application Server administrative console and click

Applications → Application Types → WebSphere Enterprise Applications.
2. Click Workplace XT.
3. Click Session management under Web Module Properties.
4. Click Enable cookies.
5. Enter a unique path in which to store this application's cookies in the Cookie

path field and click OK. For example:
/WorkplaceXT

6. Select the Override session management option under General Properties and
click Apply.

7. Click Save directly to the master configuration.
8. Restart Workplace XT.
Parent topic: “Upgrading an IBM WebSphere Application Server Network
Deployment Highly Available installation of IBM ECM Widgets V4.5.1” on page 64
Previous topic: “Verifying IBM ECM Widgets and Business Space powered by
WebSphere deployment” on page 75
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Modifying IBM Enterprise Content Management Widgets
configuration settings

There are a number of settings in your IBM ECM Widgets configuration that may
require adjustment or verification after product deployment.

The method you use to modify settings may vary based on your specific
configuration. For example, for multi-server High Availability configurations, most
settings must be made by manually editing files.

Configuration file locations and modification instructions

P8BPMRESTConfig.xml
This file contains settings for the IBM FileNet Content Engine URL and the
IBM FileNet Process Engine connection point. If these settings are not
correct, the PE REST service will fail. The P8BPMRESTConfig.xml file is
located in the following default paths:

Installation location Deployed location

ECMWidgets_Home\IBM\FileNet\WebClient\
WorkplaceXT\WEB-INF\P8BPMRESTConfig.xml

WAS_Profile_Home\installedApps\cell\
WorkplaceXT.ear\web_client.war\WEB-INF\
P8BPMRESTConfig.xml

Verify that the CE URL and PE Connection point are set correctly. For
example:
<perest:filenet.pe.bootstrap.ceuri value="iiop://localhost:2810/FileNet/Engine"/>

<perest:connection.point value="PEConnection"/>

For details regarding configuring REST services, see the Configuring REST
Services topic in the IBM FileNet P8 Platform Installation and Upgrade Guide
in the following location:http://publib.boulder.ibm.com/infocenter/
p8docs/v4r5m1/topic/com.ibm.p8.doc/developer_help/process_java_api/
guide/rest/rest_configure.htm.

bootstrap.json
The bootstrap.json file contains configuration settings for an IBM ECM
Widgets deployment. The settings in this file are modified by running the
IBM ECM Widgets configuration manager program. However, there may
be instances when you need to manually modify the file. For example,
some deployment configurations, such as High Availability, require that all
components of the configuration be deployed manually, and the
configuration manager will not be run in this case.

Attention: To manually modify configuration settings in the
bootstrap.json file, you must edit the file in its deployed location in the
WebSphere Application Server directory structure. If you manually edit this
file, ensure you make a backup copy in a location outside of the
WebSphere Application Server directory structure. The settings will be lost
if you redeploy IBM ECM Widgets and you will have to make the
modifications again.

© Copyright IBM Corp. 2010 77

http://publib.boulder.ibm.com/infocenter/p8docs/v4r5m1/topic/com.ibm.p8.doc/developer_help/process_java_api/guide/rest/rest_configure.htm
http://publib.boulder.ibm.com/infocenter/p8docs/v4r5m1/topic/com.ibm.p8.doc/developer_help/process_java_api/guide/rest/rest_configure.htm
http://publib.boulder.ibm.com/infocenter/p8docs/v4r5m1/topic/com.ibm.p8.doc/developer_help/process_java_api/guide/rest/rest_configure.htm


Important: For non-HA configurations, modify the URLs in the
boostrap.json settings by rerunning the configuration manager. Do not
change any other settings.

The deployed bootstrap.json file is located in the following deployed
location:

WAS_Home\IBM\WebSphere\AppServer\profiles\AppSrv\installedApps\
NodeCell\ECMWidgets.ear\ECMWidgets.war\catalog\com\ibm\im\
ecmwidgets\bootstrap.json

Settings Entries

URLs
Important: For High Availability
configurations, remove the port numbers for
these entries.

"bpmServiceBaseURL": "http://
localhost:9080/WorkplaceXT/P8BPMREST/p8/
bpm/v1",

"contentEngineServiceBaseURL":
"http://localhost:9080/WorkplaceXT/
P8CEREST/p8/ce/v1",

"workplaceXTBaseURL": "http://
localhost:9080/WorkplaceXT",

Default application space for IBM FileNet
Process Engine. The Process Engine uses
named application spaces. Enter the
appropriate name. For example, the default
application space when you deploy Process
Engine is DefaultApplication

"applicationSpace":
"DefaultApplication",

Service timeout settings in milliseconds. To
adjust the timeout settings, locate the
timeout entries and adjust as needed. You
do not need to restart any servers or services
after changing the values, but you must
clear the browser cache and refresh again to
pick up new settings.
Important: These settings should not be
changed unless there is a timing problem
unique to your configuration.

Default values:

"bpmServiceTimeout": 60000,
"contentEngineServiceTimeout": 900000,

Process Engine web application ID setting.
This setting corresponds to settings in the
Process Engine. A number is associated with
a specific application.

Default value:

"webAppID": 9,

IBM FileNet Workplace XT keep alive
interval (in minutes).

Default value:

"keepAliveInterval": 5,

IBM WEBi settings. If you have configured
IBM WEBi, set the URL and enter true or
false for an IBM WEBi proxy.

"webiURL":"http://localhost:9080/
wccommonservices",

"webiProxy": true_or_false,
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Settings Entries

Show repository types. Set the values as
appropriate for your configuration. Use
these settings to indicate which repository
types you have configured. If your
configuration contains both IBM FileNet
Content Manager object stores and IBM DB2
Content Manager Content servers, use these
settings to hide one or show both and to set
which one is the default.

"repositoryTypesToShow": [3,4],

Repository types:

v 3 - IBM FileNet Content Manager (FN
repository)

v 4 - IBM DB2 Content Manager Content
servers (CM repository)

Value settings:

v [3]- FN repository only

v [4]- CM repository only

v [3,4] - both FN and CM repositories, set
FN as the default

v [4,3] - both FN and CM repositories, set
CM as the default

Configuration state entry. This value set the
repository types that are configured for your
system. Set the value as appropriate for your
configuration.

"ConfigurationState":0 (default)

v 0 - Not configured

v 1 - Configured for IBM FileNet Content
Manager object stores

v 2 - Configured for IBM DB2 Content
Manager content servers

v 3 - Configured for both IBM FileNet
Content Manager object stores and IBM
DB2 Content Manager content servers

Important: Save the bootstrap.json file with UTF-8 encoding.

Configuring for SSL
To configure IBM ECM Widgets for SSL, you must update the URL settings
in the bootstrap.json file as follows:

Settings Entries

URLs
Important: For High Availability
configurations, remove the port numbers for
these entries.

Change the default settings to display the
https:// as the prefix and update the ports
as appropriate. For example:

"bpmServiceBaseURL": "https://
localhost:9443/WorkplaceXT/P8BPMREST/p8/
bpm/v1",

"contentEngineServiceBaseURL":
"https://localhost:9443/WorkplaceXT/
P8CEREST/p8/ce/v1",

"workplaceXTBaseURL": "https://
localhost:9443/WorkplaceXT",

Important: If you configure these settings for SSL, then the protocol and
port you enter to access IBM ECM Widgets and Business Space powered
by WebSphere must match the settings entered in the bootstrap.json file.
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Configuring step processor URL templates and e-mail
notification for IBM ECM Widgets

For configurations that use IBM FileNet Content Manager object stores, the step
processor URL templates and e-mail notification must be configured.

After you have installed and configured IBM ECM Widgets, the following must be
configured:
v Step processor URL templates in IBM FileNet Workplace XT
v E-mail notification on the IBM FileNet Process Engine

Choose one of the following options, based on your IBM ECM Widgets
configuration:

“Configuring IBM FileNet Process Engine for a single-instance configuration of
IBM ECM Widgets V4.5.2”
“Configuring IBM FileNet Process Engine for a multi-version configuration of
IBM ECM Widgets V4.5.1 and V4.5.2” on page 83
“Configuring IBM FileNet Process Engine for multiple instances of IBM ECM
Widgets V4.5.2” on page 85

Configuring IBM FileNet Process Engine for a single-instance
configuration of IBM ECM Widgets V4.5.2

To configure step processor URL templates and e-mail notification for your system,
you must edit settings in IBM FileNet Workplace XT and on the Process Engine
server computer.

“Configuring the step processor URL templates”
“Configuring e-mail notification” on page 82

Parent topic: “Configuring step processor URL templates and e-mail notification
for IBM ECM Widgets”

Configuring the step processor URL templates

IBM ECM Widgets V4.5.2 must be installed and configured before you proceed.

To configure the step processor URL templates for a single instance of IBM ECM
Widgets V4.5.2 for new installations and upgrades:
1. Log on to IBM FileNet Workplace XT and navigate to Tools → Administration

→ Process Configuration Console.
2. Right-click the region you want to edit and choose Connect.
3. Right-click the region you want to edit and choose Properties.
4. Click the Web Applications tab.
5. Click IBM ECM Widgets for Business Space in the Web Application column.
6. Enter the URL for the Business Space powered by WebSphere V7.0 installation

in the Server Base URL field. For example, enter http://www.bpm.com:9080/
mum/enabler

7. Click Advanced icon.
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8. Select IBM ECM Widgets for Business Space in the Launch step processor
URL Templates section and enter the following URL, in one line, in the
Template field:
{0}?nst=pid%3D{1}%26pageContext%3D%257B%2522workflowName
%2522%253A%2522{2}%2522%257D

9. Select IBM ECM Widgets for Business Space in the step processor URL
Templates section and enter the following URL, in one line, in the Step
Processor URL Template field:
{0}?nst=pid%3D{1}%26pageContext%3D%257B%2522queueName
%2522%253A%2522{2}%2522%252C%2522wobNum%2522%253A%2522{3}%2522%257D

10. Click OK and then Commit Changes.
Parent topic: “Configuring IBM FileNet Process Engine for a single-instance
configuration of IBM ECM Widgets V4.5.2” on page 81

Configuring e-mail notification

IBM ECM Widgets V4.5.2 must be installed and configured before you proceed.

To configure e-mail notification for a single instance of IBM ECM Widgets V4.5.2,
for new installations and upgrades:
1. Log into IBM FileNet Workplace XT and navigate to Tools → Administration →

Process Configuration Console.
2. Right-click the region you want to edit and choose Connect.
3. Right-click the region you want to edit and choose Properties.
4. Click the Web Applications tab.
5. Click IBM ECM Widgets for Business Space in the Web Application column.
6. Enter the URL for the Business Space powered by WebSphere V7.0 installation

in the Server Base URL field. For example, enter http://www.bpm.com:8080/
mum/enabler

7. Access the IBM ECM Widgets installation package and copy the appropriate
e-mail templates for your locale from the ProcessEngine_Templates directory
to the e-mail template directory on the IBM FileNet Process Engine server
computer. For example:

Option Description

AIX Copy the files from:

Installation_Package_Location
/ProcessEngine_Templates/email

On the Process Engine server computer, save
the files to:

/opt/fnsw/local/sd/msg/9

Windows Copy the files from:

Installation_Package_Location
\ProcessEngine_Templates\email

On the Process Engine server computer, save
the files to:

C:\fnsw_loc\sd\msg\9

8. Run Process Task Manager on the Process Engine.
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9. Click the Process Engine icon and then the Notification tab.
10. Enter your SMTP server configuration information.
11. Right-click the Language Packs folder and click New.
12. Select a locale and then click Browse.
13. Browse to the msg directory where you saved the e-mail templates and click

Select. For example:

Option Description

AIX /opt/fnsw/local/sd/msg

Windows C:\fnsw_loc\sd\msg

Important: Do not select a subdirectory within the msg folder.
14. Save all changes and restart the Process Engine.
Parent topic: “Configuring IBM FileNet Process Engine for a single-instance
configuration of IBM ECM Widgets V4.5.2” on page 81

Configuring IBM FileNet Process Engine for a multi-version
configuration of IBM ECM Widgets V4.5.1 and V4.5.2

To configure step processor URL templates and e-mail notification for your system,
you must edit settings in IBM FileNet Workplace XT and on the Process Engine
server computer.

“Configuring the step processor URL templates”
“Configuring e-mail notification” on page 84

Parent topic: “Configuring step processor URL templates and e-mail notification
for IBM ECM Widgets” on page 81

Configuring the step processor URL templates

IBM ECM Widgets V4.5.1 and V4.5.2 must be installed and configured before you
proceed.

As part of your IBM ECM Widgets V4.5.1 configuration, IBM FileNet Process
Engine step processor URL templates are already configured to use the IBM ECM
Widgets for Business Space web application with a URL of:
http://hostname/BusinessSpace/banner.jsp

Step processor URL templates for IBM ECM Widgets V4.5.2 must be configured to
use the IBM ECM Widgets for Lotus Mashups web application.

To configure step processor URL templates for a multi-version configuration of
IBM ECM Widgets V4.5.1 and V4.5.2:
1. Log on to IBM FileNet Workplace XT and navigate to Tools → Administration

→ Process Configuration Console.
2. Right-click the region you want to edit and choose Connect.
3. Right-click the region you want to edit and choose Properties.
4. Click the Web Applications tab.
5. Click IBM ECM Widgets for Lotus Mashups for IBM ECM Widgets V4.5.2 in

the Web Application column.
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6. Enter the URL for the Business Space powered by WebSphere V7.0 installation
in the Server Base URL field. For example, enter http://www.bpm.com:8080/
mum/enabler

7. Click Advanced icon.
8. Select IBM ECM Widgets for Lotus Mashups in the Launch Step Processor

URL Templates section and enter the following URL, in the Template field, in
one line:
{0}?nst=pid%3D{1}%26pageContext%3D%257B%2522workflowName
%2522%253A%2522{2}%2522%257D

9. Select IBM ECM Widgets for Lotus Mashups in the Step Processor URL
Templates section and enter the following URL, in one line, in the Step
Processor URL Template field:
{0}?nst=pid%3D{1}%26pageContext%3D%257B%2522queueName
%2522%253A%2522{2}%2522%252C%2522wobNum%2522%253A%2522{3}%2522%257D

10. Click OK and then Commit Changes.
Parent topic: “Configuring IBM FileNet Process Engine for a multi-version
configuration of IBM ECM Widgets V4.5.1 and V4.5.2” on page 83

Configuring e-mail notification

IBM ECM Widgets V4.5.1 and V4.5.2 must be installed and configured before you
proceed.

As part of your IBM ECM Widgets V4.5.1 configuration, IBM FileNet Process
Engine step processor URL templates are already configured to use the IBM ECM
Widgets for Business Space web application with a URL of
http://hostname/BusinessSpace/banner.jsp

Step processor URL templates for IBM ECM Widgets V4.5.2 must be configured to
use the IBM ECM Widgets for Lotus Mashups web application.

To configure e-mail notification for a multi-version configuration of IBM ECM
Widgets V4.5.1 and V4.5.2
1. Log on to the server computer that hosts the IBM ECM Widgets V4.5.2

installation and open the bootstrap.json file located in the following default
directory:
WAS_Home\profiles\AppSrv\installedApps\Node_Cell\ECMWidgets_node.ear
\ECMWidgets.war\catalog\com\ibm\im\ecmwidgets\bootstrap.json

2. Find the "webappID": entry and set the value to 8.
3. Log on to IBM FileNet Workplace XT and navigate to Tools → Administration

→ Process Configuration Console.
4. Right-click the region you want to edit and choose Connect.
5. Right-click the region you want to edit and choose Properties.
6. Click the Web Applications tab.
7. Click IBM ECM Widgets for Lotus Mashups for IBM ECM Widgets V4.5.2 in

the Web Application column.
8. Enter the URL for the Business Space powered by WebSphere V7.0 installation

in the Server Base URL field. For example, enter http://www.bpm.com:8080/
mum/enabler
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9. Access the IBM ECM Widgets installation package and copy the appropriate
e-mail templates for your locale from the ProcessEngine_Templates directory
to the e-mail template directory on the IBM FileNet Process Engine server
computer. For example:

Option Description

AIX Copy the files from:

Installation_Package_Location
/ProcessEngine_Templates/email

On the Process Engine server computer, save
the files to:

/opt/fnsw/local/sd/msg/8

Windows Copy the files from:

Installation_Package_Location
\ProcessEngine_Templates\email

On the Process Engine server computer, save
the files to:

C:\fnsw_loc\sd\msg\8

10. Run Process Task Manager on the Process Engine.
11. Click the Process Engine icon and then the Notification tab.
12. Enter your SMTP server configuration information.
13. Right-click the Language Packs folder and click New.
14. Select a locale and then click Browse.
15. Browse to the msg directory where you saved the e-mail templates and click

Select. For example:

Option Description

AIX /opt/fnsw/local/sd/msg

Windows C:\FNSW_LOC\sd\msg

Important: Do not select a subdirectory within the msg folder.
16. Save all changes and restart the Process Engine.
Parent topic: “Configuring IBM FileNet Process Engine for a multi-version
configuration of IBM ECM Widgets V4.5.1 and V4.5.2” on page 83

Configuring IBM FileNet Process Engine for multiple instances of IBM
ECM Widgets V4.5.2

If you have more than two instances of IBM ECM Widgets V4.5.2 running on IBM
WebSphere Application Server, use this procedure to configure the step processor
URL templates and e-mail notification.

To configure step processor URL templates and e-mail notification for your system,
you must edit settings in IBM FileNet Workplace XT and on the Process Engine
server computer.

“Configuring the step processor URL templates” on page 86
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“Configuring e-mail notification”
Parent topic: “Configuring step processor URL templates and e-mail notification
for IBM ECM Widgets” on page 81

Configuring the step processor URL templates

All instances of IBM ECM Widgets V4.5.2 must be installed and configured before
you proceed.

Note: If your configuration contains two instances of IBM ECM Widgets V4.5.2,
follow the instructions for multi-version configurations and set one of the instances
for IBM ECM Widgets for Lotus Mashups web application. For details see
“Configuring IBM FileNet Process Engine for a multi-version configuration of IBM
ECM Widgets V4.5.1 and V4.5.2” on page 83

To configure the step processor URL templates for a configuration with three or
more instances of IBM ECM Widgets V4.5.2:

Use this procedure to configure step processor URL templates for three or more
instances of IBM ECM Widgets V4.5.2, for new installations and upgrades. To
configure the step processor URL templates:
1. For each instance of IBM ECM Widgets V4.5.2, log on to IBM FileNet

Workplace XT and navigate to Tools → Administration → Process
Configuration Console.

2. Right-click the region you want to edit and choose Connect.
3. Right-click the region you want to edit and choose Properties.
4. Click the Web Applications tab.
5. Click the Add button to create a new web application.
6. Click IBM ECM Widgets for Business Space in the Web Application column.
7. Enter the URL for the Business Space powered by WebSphere V7.0 installation

in the Server Base URL field. For example, enter http://www.bpm.com:8080/
mum/enabler

8. Click Advanced icon.
9. Select IBM ECM Widgets for Business Space in the Launch Step Processor

URL Templates section and enter the following URL, in one line, in the
Template field:
{0}?nst=pid%3D{1}%26pageContext%3D%257B%2522workflowName
%2522%253A%2522{2}%2522%257D

10. Select IBM ECM Widgets for Business Space in the Step Processor URL
Templates section and enter the following URL, in one line, in the Step
Processor URL Template field:
{0}?nst=pid%3D{1}%26pageContext%3D%257B%2522queueName
%2522%253A%2522{2}%2522%252C%2522wobNum%2522%253A%2522{3}%2522%257D

11. Click OK and then Commit Changes.
Parent topic: “Configuring IBM FileNet Process Engine for multiple instances of
IBM ECM Widgets V4.5.2” on page 85

Configuring e-mail notification

All instances of IBM ECM Widgets V4.5.2 must be installed and configured before
you proceed.
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Note: If your configuration contains two instances of IBM ECM Widgets V4.5.2,
follow the instructions for multi-version configurations and set one of the instances
to IBM ECM Widgets for Lotus Mashups web application. For details see
“Configuring IBM FileNet Process Engine for a multi-version configuration of IBM
ECM Widgets V4.5.1 and V4.5.2” on page 83

Tip: If you configured step processor URL templates, begin at step 7.

To configure e-mail notification:

Use this procedure to configure e-mail notification for three or more instances of
IBM ECM Widgets V4.5.2, for new installations and upgrades. To configure e-mail
notification:
1. For each instance of IBM ECM Widgets V4.5.2, log on to IBM FileNet

Workplace XT and navigate to Tools → Administration → Process
Configuration Console.

2. Right-click the region you want to edit and choose Connect.
3. Right-click the region you want to edit and choose Properties.
4. Click the Web Applications tab.
5. Click the Add button to create a new web application.
6. Click IBM ECM Widgets for Business Space in the Web Application column.
7. For each instance of IBM ECM Widgets V4.5.2, log on to the server computer

that hosts the installation and open the bootstrap.json file located in the
following default directory:
WAS_Home\profiles\AppSrv\installedApps\Node_Cell\ECMWidgets_node.ear\ECMWidgets.war
\catalog\com\ibm\im\ecmwidgets\bootstrap.json

8. Find the "webappID": entry and set the value to the number of the new web
application you created. For example, 100.

9. Enter the URL for the Business Space powered by WebSphere V7.0 installation
in the Server Base URL field. For example, enter http://www.bpm.com:8080/
mum/enabler

10. Access the IBM ECM Widgets installation package and copy the appropriate
e-mail templates for your locale from the ProcessEngine_Templates directory
to the e-mail template directory on the IBM FileNet Process Engine server
computer. For example:

Option Description

AIX Copy the files from:

Installation_Package_Location
/ProcessEngine_Templates/email

On the Process Engine server computer, save
the files to:

/opt/fnsw/local/sd/msg/9

Windows Copy the files from

Installation_Package_Location
\ProcessEngine_Templates\email

On the Process Engine server computer, save
the files to:

C:\fnsw_loc\sd\msg\9
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11. Run Process Task Manager on the Process Engine.
12. Click the Process Engine icon and then the Notification tab.
13. Enter your SMTP server configuration information.
14. Right-click the Language Packs folder and click New.
15. Select a locale and then click Browse.
16. Browse to the msg directory where you saved the e-mail templates and click

Select. For example:

Option Description

AIX /opt/fnsw/local/sd/msg

Windows C:\fnsw_loc\sd\msg

Important: Do not select a subdirectory within the msg folder.
17. Save all changes and restart the Process Engine.
Parent topic: “Configuring IBM FileNet Process Engine for multiple instances of
IBM ECM Widgets V4.5.2” on page 85
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Configuring AJAX proxy for remote IBM WEBi installations

For IBM WEBi configurations that run remotely from the IBM ECM Widgets
installation, AJAX proxy must be configured to limit access to only specified
servers.

Before you configure the AJAX proxy, ensure the following system components
have been installed and configured:
v IBM ECM Widgets.
v IBM WEBi, on a remote server.

By default, the AJAX proxy is configured to allow access to any server. Access
must restricted to ensure access to only the servers you specify. To configure AJAX
proxy for exclusive access by remote IBM WEBi installations, choose one of the
following configuration options:

“Configuring AJAX proxy with a hidden IBM WEBi URL address”
“Configuring AJAX proxy with a visible IBM WEBi URL address” on page 90

Configuring AJAX proxy with a hidden IBM WEBi URL address
You can configure AJAX proxy to operate with a URL that does not display the
address of your IBM WEBi server.

To configure AJAX proxy for exclusive access by remote IBM WEBi installations
and maintain a hidden IBM WEBi URL address:
1. Stop the IBM WebSphere Application Server.
2. In a text editor, open the proxy-config.xml file from the following location:

WAS_Home\AppServer\BusinessSpace\mm.runtime\config\proxy-config.xml

3. Find following entry:
<proxy:mapping contextpath="/proxy/*"/>

4. Modify the entry as follows:
<proxy:mapping contextpath="/WEBiAlias" url="WEBi_URL/*"/>

Tip: The name you enter for WEBiAlias displays in the URL in place of the
IBM WEBi address.

5. Save and close the file.
6. Access the com.ibm.mm.proxy.config_Build_Date.jar file from the following

location:
WAS_Home\AppServer\BusinessSpace\mm.runtime\eclipse\plugins\
com.ibm.mm.proxy.config_Build_Date.jar

Tip: The Build_Date portion of the file name varies, depending on the build
date.

7. Unpack the JAR file and then open plugin.xml in a text editor. Add the
WEBiAlias entry as follows:

Tip:
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v On Windows, to unpack the JAR file, open it using a compression utility, or
rename the file with a ZIP suffix and then open the file. After you edit the
plugin.xml file, change the suffix back to JAR.

v On AIX, to unpack the JAR file, run the jar -xvf command. After you edit
the plugin.xml file, run the jar -cvf command to repackage the contents.

<servlet alias="/WEBiAlias" class="
com.ibm.mm.proxy.servlet.AjaxProxyServlet">

<init-param name="useJNDI" value="false" />
</servlet>

8. From the WAS_Profile_Home\Server\bin directory, run the following
commands:
a. osgiCfgInit.bat

b. clearClassCache.bat

9. Start the WebSphere Application Server.
10. From the WAS_Profile_Home\Server\bin directory, run the following

commands:
a. wsadmin

b. $AdminTask updateBlobConfig {-serverName Server_Name -nodeName
Node_Name -propertyDirectoryName "WAS_Home\AppServer\BusinessSpace\
mm.runtime\config" -prefix "Mashups_"}

c. $AdminConfig save

d. quit

11. Restart the WebSphere Application Server.
Parent topic: “Configuring AJAX proxy for remote IBM WEBi installations” on
page 89

Configuring AJAX proxy with a visible IBM WEBi URL address
You can configure AJAX proxy to operate with a URL that displays the address of
your IBM WEBi server.

To configure AJAX proxy for exclusive access by remote IBM WEBi installations in
situations where you are not concerned about users seeing the IBM WEBi address:
1. Stop the IBM WebSphere Application Server.
2. In a text editor, open the proxy-config.xml file from the following location:

WAS_Home\AppServer\BusinessSpace\mm.runtime\config\proxy-config.xml

3. Find following entry:
<proxy:policy url="*"/>

4. Modify the entry as follows:
<proxy:policy url="WEBi_URL/*"/>

5. Save and close the file.
6. From the WAS_Profile_Home\Server\bin directory, run the following commands:

a. osgiCfgInit.bat

b. clearClassCache.bat

7. Start the WebSphere Application Server.
8. From the WAS_Profile_Home\Server\bin directory, run the following commands:

a. wsadmin

b. $AdminTask updateBlobConfig {-serverName Server_Name -nodeName
Node_Name -propertyDirectoryName "WAS_Home\AppServer\BusinessSpace\
mm.runtime\config" -prefix "Mashups_"}

90 Installation and Upgrade Guide



c. $AdminConfig save

d. quit

9. Restart the WebSphere Application Server.
Parent topic: “Configuring AJAX proxy for remote IBM WEBi installations” on
page 89
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Removing IBM ECM Widgets

You can delete IBM ECM Widgets from the Business Space powered by WebSphere
Palette without removing Business Space.

To remove IBM ECM Widgets:
1. Log into Business Space and delete all pages and spaces.
2. Remove the IBM ECM Widgets catalog and templates:

a. Access WAS_Home/BusinessSpace/nodeName/serverName/mm.runtime.prof/
config/ and delete the following files:
v catalog_ecmwidgetsP8Widgets.xml

v catalog_ecmwidgetsCMWidgets.xml

b. Open catalog_default.xml and delete the following entries:
v <include catalog="ecmwidgetsCMWidgets"/>

v <include catalog="ecmwidgetsP8Widgets"/>

c. Access WAS_Home/BusinessSpace/nodeName/serverName/mm.runtime.prof/
templates/ and delete the following files:
v ECMProcessingWork.zip

v ECMStepProcessors.zip

d. Enter the following commands from a command line:
v WSadmin -conntype NONE

v $AdminTask updateBlobConfig {-serverName serverName -nodeName
nodeName -propertyDirectoryName profileRoot/BusinessSpace/nodeName
/serverName/mm.runtime.prof/config}

v $AdminTask updateSpaceTemplate {-serverName serverName -nodeName
nodeName -spaceTemplateDirectoryName profileRoot/BusinessSpace/
nodeName/serverName /mm.runtime.prof/templates -clean true}

v $AdminConfig save

3. Restart the IBM WebSphere Application Server profile.
4. Open the WebSphere Application Server administrative console and click

Applications → Enterprise Applications.
5. Select the ECMWidgets application and click Uninstall.
6. Run the IBM ECM Widgets uninstall program.

Option Description

AIX ecmWidgetsHome\ECMWidgets-Uninstall\
ECMWidgets-Uninstall

Windows ecmWidgetsHome\ECMWidgets-Uninstall\
ECMWidgets-Uninstall.exe
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs.
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“Trademarks”

Trademarks

The following terms are trademarks of the International Business Machines
Corporation in the United States, other countries, or both: http://www.ibm.com/
legal/copytrade.shtml

Microsoft®, Windows, and Windows NT® are trademarks of Microsoft Corporation
in the United States, other countries, or both.

Java™ and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in
the United States, other countries, or both.

The Oracle Outside In Technology included herein is subject to a restricted use
license and can only be used in conjunction with this application.

Other company, product, and service names may be trademarks or service marks
of others.
Parent topic: “Notices” on page 95
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